Adlib Information Systems

Copyright © 1992-2009 Adlib Information Systems B.V.® All rights reserved. Adlib® is a product of Adlib Information Systems B.V.®

The information in this document is subject to change without notice and should not be construed as a commitment by Adlib Information Systems. Adlib assumes no responsibility for any errors that may appear in this document. The software described in this document is furnished under a licence and may be used or copied only in accordance with the terms of such a licence.

Though we are making every effort to ensure the accuracy of this document, products are continually being improved. As a result, later versions of the products may vary from those described here. Under no circumstances may this document be regarded as a part of any contractual obligation to supply software, or as a definitive product description.
# Contents

1 Introduction 1  
1.1 What is Adlib? 1  
1.2 About this user guide 1  

2 Searching for items in your library, a quick guide 4  
2.1 Choosing where to search or edit 4  
2.2 How to list all the authors in a catalogue 5  
2.3 How to browse and look at the records you have retrieved 6  
2.4 How to search by author 9  
2.5 How to search on the title field 10  
2.6 How to search on the subject field 11  
2.7 How to find items catalogued this week 13  
2.8 How to combine searches together 15  

3 Creating and editing records, a quick guide 16  
3.1 Starting to create a new record 16  
3.2 Using the link screen 19  
3.3 Starting to change an existing record 22  
3.4 How do I add an image to a record? 22  
3.5 Deleting records 27  
3.6 Sorting multiple of records 29  
3.7 How to create a new record from an external source 30  
3.8 How to print out Adlib records 31  
3.9 How to Export from Adlib 33  
3.10 How to Import into Adlib 35  

4 A Detailed Guide - Starting an Adlib application 39  

5 General operation 41  

6 The user interface 45  
6.1 Window elements 45  
6.2 Working with menus, buttons and keyboard 45  
6.3 Making a selection from a list 46  
6.4 Entering text 47  
6.5 Contextual help 47  
6.6 Language switch 48  

7 Choosing a database 49  

8 Search methods 51  
8.1 Access points 51  

9 Combined searches 55  
9.1 The Combine menu (and related buttons) 55  

10 Presentation screens and buttons 57  
10.1 List screen (Brief display) 57  
10.2 Detailed presentation 59  

11 Entering, editing or removing records 65  
11.1 Entering a record 65  
11.2 Editing an existing record 66  
11.3 Deleting one or more records 66  

12 Extra functionality for data entry 69  
12.1 Linked fields 69  
12.2 Deriving records 70  

13 Authority files 71  
13.1 Entering data 71  
13.2 Domains (term type and name type) 71  
13.3 Switching to linked records 72  
13.4 Deleting records 72  
13.5 Printing 73  
13.6 Thesaurus use from the catalogue 73  

14 Sorting 75  
14.1 Sort field field parameters 75
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>15 Marking records</td>
<td>77</td>
</tr>
<tr>
<td>16 Printing</td>
<td>79</td>
</tr>
<tr>
<td>16.1 Print wizard</td>
<td>79</td>
</tr>
<tr>
<td>16.2 Windows settings for printing</td>
<td>79</td>
</tr>
<tr>
<td>17 Importing and Exporting</td>
<td>83</td>
</tr>
<tr>
<td>17.1 The Export wizard</td>
<td>83</td>
</tr>
<tr>
<td>17.2 The Import wizard</td>
<td>86</td>
</tr>
<tr>
<td>18 Customizing your toolbar</td>
<td>89</td>
</tr>
<tr>
<td>19 Appendix 1: buttons in Adlib</td>
<td>90</td>
</tr>
<tr>
<td>20 Appendix 2: Cataloguing your Library items</td>
<td>92</td>
</tr>
<tr>
<td>20.1 Recording or indexing</td>
<td>92</td>
</tr>
<tr>
<td>20.2 Starting to catalogue from scratch</td>
<td>92</td>
</tr>
<tr>
<td>20.3 Starting to catalogue where there is existing data</td>
<td>95</td>
</tr>
<tr>
<td>21 Index</td>
<td>97</td>
</tr>
</tbody>
</table>
1 Introduction

1.1 What is Adlib?

Adlib is a system that allows you to manage large quantities of information in a structured manner. The program has been designed especially for the management of data in museums, libraries, archives and similar institutions.

Adlib is structured much like a card tray, with related data being stored together. However, in Adlib the equivalents of cards are called records, and a collection of records is referred to as a database rather than a card tray. Lists, called indexes, are used so that data can be retrieved as quickly as possible. Data is entered and presented on forms that are displayed on the monitor. The layout of such a form is commonly referred to as a screen. A collection of databases, indexes, screens and, if relevant, supplementary programs that belong together are referred to as an Adlib application.

Adlib Library Lite comes as a standard application comprising of a single module: the catalogue module. This module allows the description and retrieval of items in your collection. Further separate modules can be purchased, providing more functionality for recording the activities of a library. For instance, there are further library catalogue modules providing more fields and modules providing serials management, acquisition, loans, archive or museum functionality, and a module that allows the collection to be searched on the Internet.

Adlib library applications are designed to support the Anglo-American Cataloguing Rules (2nd edition) and Dublin Core data. Adlib Library Lite contains subsets of the AACR2 and ISBD (International Standard Book Description) units of information and supports the most fundamental of the procedures, sufficient to get you started whilst still keeping to the sector’s standards.

This task manual is based on the Adlib Library Lite catalogue module. It is divided into two parts. The first is a step by step guide to allow you to get started. The second is a more detailed introduction to the way that Adlib works and expands greatly upon the Step by Step guide.

1.2 About this user guide

The manual before you focuses on the functionality of the Adlib Library Lite software.

To distinguish between descriptive text and text that you see on screen, different typefaces have been used.

- Text that is displayed on screen and used in menu titles and on buttons is in italic type, e.g.:
  Full catalogue
  Combine
  Search

- Text that you type in yourself is printed in monospace type, like that produced with a typewriter, e.g.:
  You typed this yourself...

- Keys on your keyboard are indicated with a narrow, bold font, corresponding with what is printed on the keyboard, e.g.:
  Enter
  Page Down
  F1 (Help)

- Sometimes, you have to press two keys. This is indicated by a hyphen (or plus character) between the two key names. In this case, you should press the first key and
then the second key, keeping the first key pressed down, e.g.: 
Ctrl+C

Remarks and warnings are printed in a frame like this, or just as an indented paragraph.

The way images of screens in this manual are displayed might differ from the display on your own monitor, for instance being dependent upon your Windows version and your monitor screen resolution.

![You are strongly recommended to make sure that regular backups are made of your database. If required, we can advise you on the best way to make backups.](image)

⚠️ We cannot take responsibility for your backup procedures.
A step by step guide
2 Searching for items in your library, a quick guide

2.1 Choosing where to search or edit

1. Start the Adlib Library Lite application by double clicking on the shortcut on your desktop.

2. You will see the Search Wizard which contains a variety of options.

3. Decide on the task you want to do.
   - If you want to search for or edit a book, choose Books.
   - If you want to search for or edit a video, CD or DVD, choose Audio-visual materials.
   - If you want to search for or edit an article from a magazine or journal, choose Articles.
   - If you want to search for or edit the title of a serial, magazine or journal, choose Serials.
   - If you want to search for or edit any other type of item that you may have catalogued then choose Resources.
   - If you want to search for or edit any or all of your catalogued items, choose Full catalogue.
   - The remaining databases hold data for the authority fields such as names of people or subject terms.
2.2 How to list all the authors in a catalogue

1. Start the Adlib Library Lite application. You will be brought to the database menu screen.

2. Double-click on Books. You will be brought to the second search wizard menu. This allows you to choose how you want to look for a book.

Each option lets you search the library’s catalogue on a single field.
3. Double click on the author search.

If no information is entered in the search field...

...then clicking on the Next button ‘lists’ all of the names of authors used in the catalogue. In Adlib jargon, this is an “empty key search”.

4. Click on the Next button to list all the authors in the catalogue.

You can highlight one name and click the Show button to see the records that use that name.

If you get a message stating ‘no matching record available’: then you have entered no records into Books; or your records have no authors.

2.3 How to browse and look at the records you have retrieved

1. Do a search in Adlib that finds many records (for example, follow the procedure outlined in 2.2 and then click on the All keys button). You should see a brief display of records.
2. You can select a small set of records by marking their tick boxes.

- This button lets you mark an individual record, or you can just tick the box.

- This button lets you remove all marks.

- This lets you mark all unmarked records, while unmarking all marked records.

This is a tick box: if you mark a record by ticking this, Adlib will show extra options (e.g. printing).

This is a record summary: double clicking on this will bring up the details of that record.

The number of records found is displayed in the bottom left hand corner.
3. You can now view just these selected records by clicking on the *view selection* button. You will see the detailed displays for the marked records.

4. You can look at the other ticked records by clicking on the browse buttons. Click on these arrows and see what happens.

   - The single arrows will take you one record forward or backward.
   - The double arrows take you to the first or last record.

   The arrow cannot be used if it is a grey colour since there are no more records to go forwards (or backwards) to.

5. Go back to the list of records by clicking on the back button. This should take you to the brief display again.
2.4 How to search by author

1. Select the catalogue you want to search.

2. Double-click on a catalogue to get a list of the search options. You will see the search wizard menu.

3. Double-click on author search. You will see the author search input box.

4. Type in the name of an author and press Next. You will see the brief display screen that provides a brief summary of data for each record that has fulfilled your search criteria.

   If no records are found then perhaps the book is not in the catalogue

   If only one record is found then Adlib will immediately show the record details.

You can broaden your search by only typing in part of the search term: Adlib automatically truncates the search (e.g. comp will pick terms like computer and computation, but also compatibility and company!)

5. Double click on the correct author to see the catalogue record
2.5 How to search on the title field

1. Select the catalogue you want to search.

2. Double-click on a catalogue to get a list of the search options. You will see the search wizard menu.

3. Choose the title field.

4. Enter one or more words to search on.
   i. If you enter a single word or the start of a word Adlib will look for anything beginning with that set of characters. For instance, arch would find arch, arched, archbishop, etc.
   ii. If you want to search specifically for a word and nothing more then enter the term between quotation marks, for instance “arch” will find arch but not arches nor archbishop.
   iii. If you want to do a more specific search to find a title you can use more than one word in the search. Enter the words you are looking for, for instance
searching for books on South Africa you could search on 'south africa’ (or, in fact ‘africa south’) to get any title that has these words in it. A search on either ‘africa’ or ‘south’ will retrieve more records for you to look through whereas a search on “south africa” is more specific and will find only those records with these two words in the Title field. (Word searches like this are not context specific so this search would retrieve a record with title ‘A South African colouring book’ but it would also retrieve ‘Africa south of the Sahara’).

### 2.6 How to search on the subject field

1. Select the catalogue you want to search.

2. Double-click on the catalogue to get a list of search options. You will see step 2 of the search wizard menu.

3. Choose the **subject term** field.
4. Type in the name of a subject term and press Next. You will see the brief display screen that provides a brief summary of data for each record that has fulfilled your search criteria.

5. Double click on the correct brief display entry to see the catalogue record of your choice.
2.7 How to find items catalogued this week

1. Choose the Full Catalogue to get the list of search options.

2. Choose the input date field.
3. In the ‘From Input date’ box enter the starting date of your search, so in our case a week ago.

4. In the ‘To Input date’ box enter the finishing date of your search, so in our case today.

5. Click on Next. You will see the brief display screen that provides a brief summary of data for each record that has fulfilled your search criteria.

6. Double click on the correct brief display entry to see the catalogue record of your choice.

When altering the date you can do it in two ways:
A. Overtype the existing text. Clicking on the part of the text you want to change will highlight it then just type in your new number representing the year, month or day.

B. Use the calendar functionality. Clicking on the drop down arrow will bring up the calendar display box. You can click on a date within this month to choose it; click on the forward and backwards arrows to move forwards or backwards a month at a time; click on the month itself to choose from the list of months; click on the year to change the year; or click on today to choose today’s date.
2.8 How to combine searches together

2.8.1 Searching for Author and Title

1. Do a book search using the title search box. You should now be in a brief or detailed display of a record.

2. If Adlib has retrieved too many titles you can refine your search by clicking on the AND button on the tool bar. You will be brought back to the search key menu.

3. Choose the author search and type in a title. Press return or click on Next. Adlib will now search for your title from the first group of records.

   - You could try broadening your search using the or button

   - You could try restricting your search using the not button

Summary:

- **AND**: All conditions must apply.
- **OR**: Either or all conditions can apply (at least one must apply).
- **NOT**: The first condition must apply but the second must NOT apply.

These buttons help you combine searches – clicking on one brings you back to the list of search keys. They allow Boolean searching.
3 Creating and editing records, a quick guide

3.1 Starting to create a new record

1. Choose a catalogue from the main database menu.

   
   - The *new record* button will be on the toolbar when you enter a catalogue:

   ![New record button](image1)

2. 

   - Click the *new record* button to open a blank record.

   You will see a blank record with 3D fields. It will say ‘new record’ on the bottom left hand corner of the screen.

   ![Blank record](image2)
3. Use the mouse to click on the fields. You can now enter information in the fields.

If you see the following screen, you are in a field that requires information.

Click Postpone to close this box and to put off the moment that you must complete this field.

4. Click the tabs to change screen.
5. Save the record by clicking the save button.

### 3.1.1 What things can I do with an Adlib field?

1. Go to a detailed display of a record and press the edit button. This will allow you to change the contents of a record. The fields should have a 3D look-and-feel.

2. Click the *author* field and look at the tool bar. Some buttons will no longer be greyed out, for instance the append occurrence buttons.

These buttons allow you to add and remove new lines for a particular field.

3. If a screen pops up then you are not in edit mode. Close the screen and click on the *edit* button.

4. Hold the mouse pointer over any of these buttons and Adlib will display the name of that button.

5. Click the *append occurrence beneath* button. New blank *author* lines should appear beneath the first line of the field.

6. Place the cursor in one of the blank lines and press the *delete occurrence* button. The blank line will be removed.
6. Now try using some of the other field buttons to see what happens.

If a screen appears, like the one below, clicking on the Cancel button will bring you back to the record. This is called a link screen.

![Linked record search screen](image)

7. Leave your record by clicking on the Back button and saying No to save. If you clicked Yes to save, any additional empty field lines will be removed.

3.2 Using the link screen

1. Edit an existing object record or create a new record. Your screen may look like this:
2. Click on the author field. Find the List button.

This creates a new linked record, if no link has been made, otherwise you can edit an existing link.

3. Click the List button. The link screen will appear.

You can search for information in this box, the list changes as you type.

Double-clicking a term will pull it across (i.e. link) to your library record.

Clicking OK will link the term to your record.

4. Choose a term by double-clicking or pressing the OK button. The term will now appear in your field.

5. Save your record. The term will now be underlined: clicking on the term brings up the linked record screen.

3.2.1 Using the list button to validate information in a field

1. Go to a detailed display and press the edit button.

2. Click on the author field.

You should be able to see the list button. This means the field is linked.

3. Type in an author and click on a different field.
Adlib will search for the author in the Persons and institutions database (or authority file). If it finds the term, it will place it in the field. If it does not find the term, the link screen will appear.

4. Click OK to remove the dialogue box.

5. Check the term you entered. If the term already exists and you have made a slight spelling mistake, choose the existing term. If the term does not exist then put it into the list by either clicking on Add term or on New record.

Add term forces the term into the authority list. It is easy to use this to add terms to a list but it can also add incorrect terms if you do not check the list thoroughly before clicking on add term.

3.2.2 Using a linked field to change a record

1. Go to the detailed display of a record.

2. - Click the Edit button.

3. Place the cursor in the author field. You will see the edit linked record button become active on the tool bar. This lets you go to the persons and institutions database and change the details of that record.

4. - Click the edit linked record button. You will see the persons and institutions zoom screen.

5. You can now add any new details to the persons and institutions record. (See Appendix 2 for guidance on creating terminology.)
6. Now you can save your changes using the Save button. Click on the underlined author to view your changes.

### 3.3 Starting to change an existing record

1. Find the record you need to change (edit). You will need to be in the detailed display of a record before you can edit it. You can use the basic search keys to find your record.

![Adlib Library Lite 3.4 - [Books : Title] (Free Version 6.4.0, build 412)](image)

2. - Click on the *Edit* record button. The fields you can edit will have a 3D look-and-feel.

3. You can click on the field you need to change or use the tab key to move between the fields (or Shift+tab to go to previous fields). The cursor will always show you what field you are currently in.

4. - Save your changes by clicking on the Save record button and clicking on Yes.

   If you have made no changes you can leave the record by pressing the Back button and saying No to save.

### 3.4 How do I add an image to a record?

These instructions refer to images that are already saved on your computer (e.g. they might be scanned in). Adlib lets you associate a record with an existing image.

1. Create/edit a record that requires an image. Click the *Reproductions* tab
2. The cursor will be in the reference field.
3. Click on the **Find image file** button. A dialogue box will appear – this will let you find your image on the computer or network.

   ![Image Finder Dialogue Box]

This button opens the **look in** drop down box – you can use this to start looking for the image.

4. Click on the **Look in** drop down box. Adlib will show the current directory it is in (usually the **library lite** directory):

   ![Library Lite Directory]

This is an **adlib application directory** – directories are displayed as yellow folders.

5. Click on the Adlib application folder to find the image directory. A list of Adlib directories will appear in the dialogue box:
6. Double click on the *Images* directory. A list of image files will appear in the dialogue box (for example, jpg or bmp files).

7. Double click on the image file associated with your library item. The image will appear in an image viewer and the pathname of the file (i.e. where the image is stored in on the computer/network) will appear in the *reference* field. The reference will be automatically created.
8. You can now save your record.

### 3.4.1 Dragging and dropping images

1. Create/edit a record that requires an image. Click the reproductions tab.

2. In Windows, click on start and choose Computer.

3. Find the directory holding your image files.
4. Use the functionality of Windows to size and move your Explorer window so that you can see both the explorer window and your Adlib application.

5. Highlight the file that you want to show in Adlib.

6. Drag the file and drop it into the image browser.
3.5 Deleting records

3.5.1 Deleting a single record

1. Go to the detailed display of the record you want to delete.

2. - Click on the delete record button. Adlib will ask whether it is 'OK to delete this record?'

You cannot delete in edit mode
3. Click on Yes to confirm that you want to delete this record. The record should now disappear.

3.5.2 Deleting multiple records
1. Retrieve more than one record and go to a brief display.
2. Mark the records you want to delete using the tick boxes.
3. Click on the delete record button.
4. Click on **delete all marked records** and click on **OK**. The marked records should now be deleted.

*Delete current record* refers to the highlighted record, not the ticked records!

*Delete all marked records* will delete these ticked (marked) records.
3.6 Sorting multiple of records

1. Go to a brief display that has more than one record. You cannot sort less than two records!

2. - Click on the Sort button to open the sort dialogue box.

3. Select sorting by author by highlighting that field in the left box and pressing the right pointing arrow. Author should now appear in the second box, sort field properties.

4. - Click the Sort button and Adlib will sort the records by author. You will be brought back to a sorted brief display.
3.7 How to create a new record from an external source

1. Choose a dataset such as Books.

2. Click on Record on the menu bar.

3. Choose Derive Record and pick an external source.

4. A Query By Form opens.

5. Enter a search.
   If you are entering an author or a subject and you are not certain of the complete name or term use a truncation mark to find any subsequent characters, e.g. Browning* will find any author whose name starts with Browning. (Names are usually entered Surname, Forename)

The author and subject fields search on precisely what you enter but using the * after the name or term will change the search into being any name or term starting with what was entered.
You cannot use the * in the middle of a name or term or at the beginning.

6. Click on Enter or the search button to run the search.

7. A set of results will be returned.
8. Choose the book you would like. Click on OK
   This will create a new record with all the data from your chosen book.

9. Save the record.

3.8 How to print out Adlib records

1. Find some records by searching on the Adlib application. The records should be listed on the brief display.

2. Mark the records you want to print. All the required records will have ticks in the tick boxes.

   - The print button will become active on the toolbar.

3. Open the print dialogue box by pressing the print button. The following screen will appear:
4. Choose ‘Create report with predefined output format’ and click Next.

5. Choose the output format you would like to use and click Finish.

6. Choose the printer you would like to use. The following screen will be visible:
7. Click on OK to begin printing. A progress bar will appear indicating how much of the printing is completed.

8. The print application will close after the report is printed.

### 3.9 How to Export from Adlib

1. Use Adlib searches to find the records to be exported.

2. Mark the records to be exported.

3. Click on File in the menu bar.

4. Choose Export.

5. Select the type of export to be done.
6. Choose the fields to be exported. Highlight the field to be exported and click on the single arrow. Clicking on the Double right arrow will select all fields to be exported.

9. Enter the path for the destination file. Use browse to find a folder for the file or type the path in directly.
10. Choose Finish. This will run the export routine.

If you choose CSV as the export type then save the results to a file with the extension.csv then you can open this in Excel.

CSV as a format cannot handle multiple occurrences so you will only get the first occurrence exported.

3.10 How to Import into Adlib

1. Enter database you want to import data into.

2. Click on File in the menu bar.

3. Choose Import.
4. Select the type of import to be done.

5. Choose the source data file to be imported. You can click on Browse to find the data source file.
6. Mark the *Ignore record numbers* option to provide records to be imported with new record numbers. This way you prevent existing records in the target database from being overwritten.

7. Choose *Next* to start the import routine.
4 A Detailed Guide - Starting an Adlib application

When you download Adlib Library Lite it comes as part of an automatically installing package. Follow the instructions and Adlib Library Lite will be installed on your PC plus a shortcut to the software will appear on your desktop. You can double-click on the shortcut to start the application. Alternatively you’ll find an Adlib icon in the Programs group of the Windows Start menu; click the icon once, to start the application.

After start-up the Adlib logo is displayed briefly then you enter the file menu (see Figure 5.1).

Note that Adlib Library Lite can only be started from the computer on which it has been installed. So you can’t install it on a server and then open it from workstations in the network.
5 General operation

When you work with Adlib, you will usually go through a number of steps in a fixed sequence. Simply searching for data, for instance, goes as follows:

1. Start an Adlib application by double-clicking the Adlib icon (shortcut) on your desktop or open the Windows Start menu, go to Programs → Adlib software and choose the application.

2. A list of available files (databases and datasets) will appear in the file menu (also called main menu or database menu) in the Search wizard (see Figure 5.1). In the Search wizard you specify which data you are looking for, step by step. In the Description field you'll find some useful help.

3. After selecting a file or dataset, a new list will appear in the Search wizard. This is the access points menu, from which you can select an index on which Adlib will search; double-click an access point, or select it and then click the Next button or press Enter. (You can also use the arrow keys, or repeatedly type the first letter of the desired access point until the right one is selected.) Each access point is linked to an index in which Adlib will search.
General operation

Figure 5.2: Each access point denotes an index in which you can search quickly.

4. When you have selected an index, then in the next window you can type in what you want to search for: the search key. For searching it suffices to type the first few letters of the index key.

5. If an index contains more than one term beginning with the characters you entered, all these terms will be displayed in the Search results list. (This does not apply on some indexes, like the one for Title.) Choose one and click Show, or search further on all keys by clicking the All keys button. This step will, of course, be skipped if only one term matches your search criterion.

Figure 5.3: This first search result displays all found terms in the index you chose.

6. All the records that are retrieved (the records for which the chosen index contains the search key you entered or selected) are then displayed as a list on the Brief display screen (see Figure 5.). You can choose a record from this list (double-click or press Enter), after which the selected record will be displayed in detail, spread out over several screens.

Figure 5.4: The Brief display: the records found for this author.
Working in Adlib usually proceeds in a series of steps; in the menu and the toolbar there are always two functions present, with which you can go back to a previous step.

Click the Restart button, choose File → Restart, or press F8 to return to the screen with which Adlib opens – in effect you start over again – and choose a new data file to work with.

From anywhere in the program, step back one screen or level via the File → Back menu, press F7, or click the Back button.

For browsing through records, use the buttons for this purpose (First record, Previous record, Next record, and Last record):

In Adlib there are of course many more possibilities, such as:

- creating new records;
- editing existing records;
- outputting records to a printer;
- making complex selections;
- sorting records;
- working with sets of records;
- deleting a selection of records.

All these functions will be discussed later on in this user guide.

Adlib strongly recommends that you make sure regular backups are made of your Adlib folder. If required, Adlib can advise you on the best way to make backups, although Adlib cannot accept responsibility for your backup procedures.
6 The user interface

6.1 Window elements

Adlib applications have a typical Windows interface and work much like other Windows programs. In Figure 6.1 the Windows labelling of frequently used window elements is shown.

With the three buttons in the upper right corner of the Adlib window, you can minimize the window (to a shortcut on the Windows taskbar), maximize it (make it fill the screen), resize it to the former dimensions, or close the program.

The status bar displays additional information, such as the number of records in a list, the character set and type of the databases used, or a suggestion about what to do next.

6.2 Working with menus, buttons and keyboard

In Adlib, functions can often be executed in different ways; this is true for searching as well as for entering new records and minimizing or closing windows.

**Menus**

Most functions can be found in the menus; click (always with the left mouse button, unless stated otherwise) the title of a menu (e.g. File), move the mouse downwards and click a function that is not greyed out (e.g. Restart).

Greyed out functions are functions that you cannot execute because they are not applicable right now; they do become active in other windows or under other circumstances.
The user interface

You can also reach the menus through the keyboard. Press Alt and press the underlined letter in the label of a menu (e.g. Alt+f to open the File menu). Again choose an underlined letter of the desired function, or choose a function with the arrow keys and press Enter.

Buttons (icons)

Frequently used functions and commands are also located on the toolbar. Let the mouse pointer hover over a button and a tooltip appears that explains the button. Click the button to execute the function.

Buttons may have a label or an icon on it. An overview of all Adlib icon buttons and their function is included at the end of this user guide in Appendix 1. Also see chapter 10.

All buttons that may occur on the toolbar are always present, but will be greyed out if the associated function is currently not applicable. The advantage of this construction is that buttons are always on the same location in the toolbar, which makes them easier to find.

The toolbar is divided into sub toolbars that are separated by a vertical line, for instance:

In some sub toolbars you'll see all buttons immediately, while other sub toolbars are (currently) too short to display all of the buttons in them and therefore show >> on their right side: click it to display the other buttons in that sub toolbar, and you can click those buttons if the text next to it isn't displayed greyed out, for example:

To a certain extent, you can adjust the arrangement of the toolbar to your liking. Note that this means that your toolbar may appear different than in the screen shots in this and other Adlib manuals.

Shortcuts (key combinations)

When the File menu is opened, next to Back and Restart you'll see F7 and F8 mentioned. This means that you can execute the relevant functions, by pressing the function keys F7 and F8 on your keyboard, without moving the mouse to the menu bar first. A number of functions can also be executed via a key combination with Ctrl.

Choose your favourite method

As far as the end result is concerned, it is not important how you start a function, but some people prefer working with the mouse, while others prefer the keyboard.

For the sake of succinctness, in this manual usually only one of the above mentioned ways of executing a function will be mentioned, for instance through a button, but instead you can use the menu or a function key just as easily. (Note that not all functions have function keys or key combinations assigned to them.)

6.3 Making a selection from a list

Many Adlib screens allow you to choose from a list of options. In such a list always one item is selected, marked with a distinctive background colour. Simply choose another by clicking the item; again click the item to use or open it. Sometimes though, it takes double-clicking (clicking two times rapidly) an already selected item, to obtain the same result, for instance in the Search wizard. When clicking once doesn't do the trick, double-clicking should.

A different way to select another item is to use the cursor control (arrow) keys ↑ ↓ to highlight the desired option and then press Enter to open or use the item.

If the selection list is longer than will fit in the available space, you can move up or down through the text using the arrow keys. You can also do this by dragging the scroll box in the scrollbar using the mouse pointer. By clicking the scrollbar just above or below the scroll box, you can move through the list whole pages at a time. You can also do this with the Page Up and Page Down keys. Alternatively (in the Search wizard), you can type in the first letter of the option. The next option starting with the letter you just entered will be highlighted.
6.4 Entering text

Text is always entered in the same way in Adlib. On the line where you want to enter or edit text, a blinking line (the cursor) will show the insertion point and the entry field that is active. There is always only one active field and text you type will be inserted in this field. The cursor is where the next character will be placed. During typing the insertion point will move to the right.

6.4.1 Moving the cursor with the mouse

You can move the cursor by moving the mouse pointer to an entry field where you want the cursor to be and clicking once. This way you can enter text in different entry fields.

6.4.2 Moving the cursor with the keyboard

There are a number of key combinations that you can use when entering text. These are listed in the table below.

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Cursor to the left</td>
</tr>
<tr>
<td>→</td>
<td>Cursor to the right</td>
</tr>
<tr>
<td>Home</td>
<td>Cursor to the beginning of the line</td>
</tr>
<tr>
<td>End</td>
<td>Cursor to the end of the line</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Cursor to the beginning of the occurrence</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>Cursor to the end of the occurrence</td>
</tr>
<tr>
<td>Backspace</td>
<td>Delete the character to the left of the cursor</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the character to the right of the cursor</td>
</tr>
<tr>
<td>Enter/Return</td>
<td>End of input in the Search wizard</td>
</tr>
</tbody>
</table>

When creating or editing records, you can jump to the next field using the Tab key. Shift+Tab will take you to the previous editable field. In descriptive fields, such as Notes, you can continue typing as long as you like. If the last word does not fit on the line, it will automatically move to the next line on the screen. This “word-wrap” function does not work in the other fields, because there you are not supposed to enter lengthy text. For certain fields you can add duplicates though (called occurrences) of that field, in order to be able to store more terms. You can add an occurrence by placing the cursor in the concerning field and then clicking one the buttons Append occurrence above, Append occurrence beneath, or Add occurrence below:

Or press Ctrl+Enter to insert an occurrence beneath the active field, via the keyboard. Jump to the next tab (screen) with Ctrl+Tab and to the previous screen with Shift+Ctrl+Tab.

6.5 Contextual help

If you require more information than is given in the status bar, you can call up extra information about the active field or screen by pressing F1 (Help). The Adlib Help function is also available via Help → Information, or click the Information button (in the toolbar) or the Help button (in the Search wizard):

The help texts are displayed in a separate window (see Figure 6.2).
The user interface

The help text shown by Adlib is context-sensitive, i.e. it depends on the screen or the menu and the highlighted option. Click another option (in the Search wizard) or another field (when entering records) and the Help window immediately displays an explanation. Close Help via the Close button in the upper right corner of the Help window, by pressing F1 again, or by choosing the Information command again in the menu or the toolbar.

The Help window can be made wider or smaller by moving the cursor over the (left) border until you see a double arrow, and then dragging that border to the left or right. Adlib saves the new width for the next time that you open the Help, even after Adlib has been closed in the meantime.

You can position the Help window on the other side of the screen too. Right-click the Help window and choose Dock left or Dock right in the pop-up menu.

6.6 Language switch

In most Adlib applications, you can choose between English, Dutch, German and French. You can change the interface language via the Language switch menu at any time while working in Adlib.

The first time you start Adlib, it will be in English. After that, Adlib will open in the language in which the last user closed the application.
7 Choosing a database

Figure 7.1: Choose a database or dataset to work with.

In the first window of the Search wizard (the database - or file menu) you choose a data file to work in. Move the selection bar that highlights the first file by default to the file of your choice with the mouse or arrow keys (↑ and ↓), or type the first letter of the file and double-click it, click the Next button, or press Enter.

After choosing a file, a list of access points opens in the Search wizard.
8 Search methods

In Adlib Library Lite you can search using Access points. In the Search wizard choose an access point to search on. A search is performed only on this field.

8.1 Access points

After selecting and opening a database, you arrive in the access points menu in the Search wizard (see Figure 8.1). On this screen, you can choose which access point you want to use to find records. An access point provides a means of searching the database by a certain aspect of the records.

![Search wizard - Step 2 of 4](image)

Figure 8.1: The available access points for Library Lite.

8.1.1 Submitting a search key

After selecting an access point, in the Search wizard a search form opens. Here, you can enter what you want to search for. You want Adlib to show you all records for which the access point has a certain value. If you chose Author in the example above, then type the last name of the writer of the book, or only the first few letters of the author’s name. This value is known as the index key or just as the key.

When you click the Next button or press Enter, Adlib searches for all records in the current database or dataset in the field that corresponds with the chosen access point where the data complies with the submitted index key. During a search the key will be compared to words/terms that appear in the index of that field.

The way the search is carried out depends on the type of data you are searching on, and the way the data is indexed as an access point. The possibilities are as follows:

- indexing on a term (e.g. Author or Subject term): fields which usually need only one or just a few accurately defined terms to specify them. In the latter case searching is always done starting at the beginning of the first word in the term;
- indexing of text on words (e.g. Title or Abstract, in which you enter multiple words or sentences);
- numerical data and dates.

During a search, Adlib will ignore any letters with accents, and will not distinguish between upper and lowercase letters. That is to say: for searching, letters with and without diacritical characters are treated equally. So when you’re looking for café you’ll also find records with café and the reverse is also true.

In indexes on term or on word, you can search with just one letter. And in a term index you can even search with an empty key (filling in nothing).
Search methods

8.1.2 Indexing on term

With indexing on term, the entire content of the field is used as an index key, even if it includes spaces or punctuation marks. The index key for a term index may therefore also contain spaces and punctuation marks, and at the beginning of a field there may also be spaces. Adlib will ignore preceding spaces when indexing.

Indexes on term include: Author, Material type, Publisher and Subject term.

Type in the first letter or several letters to get the required term. Spaces preceding a search key will be ignored.

- **Truncation**
  
  It is possible, but not necessary, to type in the full term. Not entering the end of the key is known as right truncation. One speaks of a ‘truncated search key’ or a ‘truncated search’. The default setting for automatic truncation in all Adlib applications is on.

  Automatic truncation for the search key: a1 in the access point Author might result in Alcock, Pete, Aldinger, F., and Allen, Robert.

  If you want to enter the full key (non-truncated searching) then you must enclose the search key in double quotes ("). With for instance: “Bond” you will only find the full authors name Bond, but not Bond, J.M.

- **Searching for key values**

  ![Figure 8.2: Found index values for the search key 'fin'.](image)

  When you have entered your search key, the system will search the index and then show a list of all terms for the selected access point beginning with your search key. From this list, you can choose the index key about which you want more information.

  There is a limit on the number of keys that Adlib will display initially. When the search yields more than 100 terms, then still only a 100 terms will be displayed. Behind Search results always the exact number of keys found is stated. Only a part of the search result will be displayed because showing the entire list (including possible tree structure) may take too long and can take up a lot of memory space, when the list is very long. Press the Page Down key a number of times, or use the arrow key ↓, to expand the list with a following part each time you press that key, until the complete index is being displayed.

- **Counter and limit**

  During the index search a counter shows how many index terms have been searched so far (see Figure 8.3):

  ![Figure 8.3: The index is being searched.](image)

  This counter is normally incremented in steps of 10. When the limit for the number of terms that can be retrieved has been reached, a message will appear that Adlib has stopped searching.

- **Interrupting a search**

  You can interrupt a search by pressing any key. Adlib will then break off the search process and will ask you if you want to stop the current search (see Figure 8.4).
If you select No, Adlib will continue searching. If you select Yes, Adlib will stop searching and will display the results found thus far.

![Image](image.png)

**Figure 8.4:** When a search takes too long, you can break it off.

**Retrieving records**

Choose one of the retrieved terms and click the Show button or press Enter. Adlib will now select all records that contain the full key value for this access point, and will display them in the Brief display list screen. (If only one record is found for the full key, then Adlib will display the concerning record immediately.)

If you select All keys, all records are selected for all key values in the term index and displayed in the Brief display screen. The possibilities of this presentation are discussed in chapter 10.1.

You can still interrupt a search by pressing any key.

**8.1.3 Word indexes: free text**

With word indexing, Adlib uses each separate word in the field as an index key. Examples of word indexes (or free text indexes) are: Title and Abstract. In a word index you can search on one letter (the first letter of the word you are looking for). For instance, the document title 'C++' can be found upon submitting c, but also upon submitting c++. If you enter spaces or punctuation marks in the search key of a free text field, you will find these words with or without their separators and concatenators. Example: l’arbre can be found on l’arbre as well as on arbre.

Separators are: ;!,()[]{}<> and blank spaces, new lines and tabs.

Concatenators are: `|--//#\+$%^&_+*"'

You can indicate that a key is complete by embedding the word in double quotes. Now Adlib will search for the records that contain all the words entered for the selected access point. If no matching records are found (for all submitted words), those records are selected that contain as many of the words entered as possible.

An example: you are looking for a painting in your collection and you know that the title includes the name 'Pearce' and the word 'Mrs'. What you don't know is whether 'Pearce' is spelled 'Pearce' or 'Peerce'. You select the access point Title and in the search screen you type:

pe mrs

If automatic right truncation has been switched off for 'free text' searches in your Adlib application, you will get the same result with:

pe* mrs

Adlib will then search (truncated) on the partial key pe and the full key Mrs in the title word index and will find the title: *Portrait of Mrs Pearce* by Francis Wheatley.

So, with 'free text' searches, it is not necessary to type the full index key.

**8.1.4 Numeric or date**

If you have selected an access point for a number or date, e.g. Record number or certain date fields, you can enter two index keys (in two entry fields) in the search screen in the Search wizard: the start key in the first entry field and the end key in the second. Then, Adlib will display a list of all full index keys that come under the given range.

For searching on record number, records with a value within the submitted range are selected and displayed in the Brief display. Adlib automatically searches on full keys.
Search methods

With numeric searches, the keys must consist exclusively of digits. For searching on a date you submit keys in the format yyyy-mm-dd. This happens automatically when you open the drop-down list of a date entry field and choose a date in the calendar.

This type of index does not allow you to search with a truncated term. You can search on one particular value by making the start and end keys the same.
9 Combined searches

9.1 The Combine menu (and related buttons)

You can combine searches in a brief display screen or a detailed presentation screen by choosing one of the available commands from the Combine menu.

When combining is allowed in your application, there are three possibilities to combine the result of a search with a new search: the Boolean operators AND, OR and NOT. Use these functions in the Combine menu or the buttons with the same name, for reducing or expanding the current search result.

- **AND** reduces the current search to records that also contain the new search key to be entered. The result will therefore be smaller.*

- **OR** expands the current selection with other records that contain the new search key to be entered. The result will therefore be greater.*

- **NOT** removes from the current selection all records that contain the search key to be entered. The result will therefore be reduced.*

* if the new search does not result in any reduction or expansion of the number of records, the result will, of course, stay the same and the current selection will remain in place.

**Example**

A search on the title **africa** has resulted in twenty one records.

If you choose **AND**, **OR** or **NOT**, the access points menu in the Search wizard opens again. You may choose a new access point and enter the search key for it.

If you carry out an **AND** action with author’s names beginning with **c** (author = **c**, and use All keys), three records will remain: the record for which the word ‘africa’ appears in the title and for which the author’s name starts with a ‘c’. That is both conditions must apply.

If you use **OR** for a combined search on authors that start with a ‘c’, then all records that have an author with a ‘c’ are added to the selection. In this example this results in sixty records. That is either condition may apply.

A **NOT** combination on authors whose names begin with ‘c’ results in such authors being removed from the previous selection. There will be eighteen records left, from authors whose name doesn’t start with a ‘c’ (but which have ‘africa’ in the title field).

If you return to the access points menu in the Search wizard with **Back** (not after choosing one of the Combine buttons) you will lose the selection you achieved by combining searches together.

After combining searches, you will see a brief display with the results of the old and the new searches together (or you will go directly into a detailed display screen if there is only one record). By choosing a Combine search again you can, if you wish, perform a new combination search.

If Adlib does not find any records after a combined search, the following message will appear, and Adlib will save the result of the previous search:
Sometimes the message is different and just states that no matching record is available. You return to the search screen with which you performed the last search. Click `Cancel` one or more times (or first `Back` when you are in `Query by form`) to return to the last search result, or use the search screen to specify the new search.
10 Presentation screens and buttons

10.1 List screen (Brief display)

The Brief display screen (or list screen) shows a list of retrieved records.

Figure 10.1: An example of a list screen.

The main purpose of the brief display is to present the current search result as a list of records. You can double-click the text of a record to view the detailed display of that record.

**Buttons for the Brief display screen**

- **Restart**: choose another database to work with.

- **Back**: go back to the previous screen.

- **First record**: jump to the first record in the search result.

- **Previous record**: go to the previous record in the search result.

- **Next record**: go to the next record in the search result.

- **Last record**: jump to the last record in the search result.
**Presentation screens and buttons**

*Edit record:* edit the current record. If the button is greyed out, then **Restart** and choose the dataset, not the database, in which the concerning record occurs. It’s also possible that if you have no permission to edit records, then this button will remain inactive.

*New record:* add a new record to the current dataset. This button is only present when you are working in a dataset or in a database that is not subdivided into datasets.

*Delete record:* from the **Brief display**, delete either the current record (the highlighted record) or all marked records (with a checkmark in front of them) from the data file; Adlib offers you that choice after you’ve clicked this button, while at least one record is marked. Click **OK** to confirm your choice and remove those records permanently. The button is only present when you are working in a dataset or in a database that is not subdivided into datasets. Note that Adlib also asks for confirmation if you delete the current record while no records have been marked.

*AND:* reduce the current selection using an AND search (see chapter 9).

*OR:* expand the current selection using an OR search (see chapter 9).

*NOT:* reduce the current selection using a NOT search (see chapter 9).

*Mark record:* mark the selected record. This button is ‘pressed in’ when the record is marked (see chapter 15).

*Toggle marks:* mark all unmarked records and unmark all marked. (See chapter 15).

*Remove all marks:* delete all marks (see chapter 15). This button is only present when there are marked records.

*Sort:* specify on which fields the record list must be sorted (see chapter 14).

*Print:* open the **Print wizard** dialog for the marked records. This button is only available when records have been marked (see chapter 16).

*View selection:* click this button to browse only the marked records; do not click it if you want to browse all records. When you are browsing only through marked records in the detailed presentation, then click this button again, and in the list screen only the marked records will be left. This function is only available when records have been marked.

*Information:* context-sensitive Help for the active (selected) item.

When a button is greyed out, it means that it cannot currently be used. An example is the button you use to jump to the first record, when you are actually on that record. Then the icon is light grey instead of blue.

### Editing a record

In the **Brief display** click the **Edit record** button to edit the currently selected record. See chapter 11 for more information.
Marking records
The different ways of marking records (and unmarking them) for editing, will be discussed in chapter 15.

Sorting records
The sorting of records will be discussed in chapter 14.

Combining searches
It is possible to combine multiple searches, and to create selections of records for which one search statement would be insufficient. See chapter 9 for more information about this subject.

10.2 Detailed presentation
The detailed presentation of a record is spread out over multiple tabs (or screens), which are accessed through the search and brief display screens. You can navigate between the tabbed windows by clicking the tabs. Alternatively, the key combination Ctrl+Tab will move you to the next tab, and Ctrl+Shift+Tab will move you to the previous tab.

In the detailed display of a record, you can hide or show the screens presented for each record. This may be useful to hide screen tabs which you never use, although any filled-in data on those screens will still be saved in the record.

Open the Screen tabs menu and click the name of a tab to hide that screen (the green check mark to the left of the name is removed), or to show it again (the green check mark reappears).

Sometimes more information has to be shown than will fit on the screen. In that case, a scroll box will appear in the scroll bar of the window, and the arrows on the scroll bar will become active. You can move up or down in the screen by dragging the scroll box or clicking the arrows. You can scroll with the arrow keys on your keyboard as well, and usually* also with the scroll wheel that is present on many computer mice.

* Scrolling with a mouse wheel in Adlib under Windows 98 doesn't work, though under Windows 2000 it always works, but under Windows XP only if you first click the caption (the name) of the (current) tab sheet and click it again after each time that you have clicked somewhere in the tab sheet (e.g. to activate a field) and want to scroll with the mouse again.

You may change the font and font size of the detailed display if you wish: click the Options menu and select Font... The default font is MS Sans Serif, size 8.

The adjustment of font and size applies only to the display of text in the list screen and detailed presentation of records, and to the different lists in the Search wizard.

Underlined values in display mode
Sometimes, a value on a detailed display is underlined. This is a reference to the linked record for that term or name in the same or another dataset/database. For instance, you have a Persons and institutions database to register personal details, amongst which is the proper way of writing the name. Now, if you enter a record of a book in another database, and somewhere you enter the name of the writer, then such a field is validated against the linked database Persons and institutions. That means that when you enter a name in this field that does not occur in Persons and institutions, Adlib will ask you if you want to add that name to it. Instead of adding it, you may also pick an existing name and have it entered in the current field, in the preferred spelling. In the detailed presentation of a record, such linked terms or names will be displayed underlined.

You may click such a link to display details of the concerning term or name record, as they are registered in the linked dataset/database. Those details may be presented in two ways. If the link refers to a record in another dataset or database, like in the example above, then a so-called zoom screen will be opened: this is one screen in a separate window, in which you can see a selection of details from the linked record. If you’ve seen enough, you can close that zoom window via the button with the little cross on it, in the upper right corner of this window (see Figure 10.2).
Presentation screens and buttons

Figure 10.2: The detailed presentation of a library record for a book, with on the right the zoom screen for the Persons and institutions name “Batchelor, Peter” used in the author field.

**Buttons in the detailed presentation**

- **Restart**: choose another database to work with.
- **Back**: go back to the previous screen.
- **First record**: jump to the first record in the search result.
- **Previous record**: go to the previous record in the search result.
- **Next record**: go to the next record in the search result.
- **Last record**: jump to the last record in the search result.
- **Save record**: stop entry/editing (with or without saving).
- **Edit record**: edit the current record. If the button is greyed out, then Restart and choose the dataset, not the database, in which the concerning record occurs. It’s also possible that if you have no permission to edit records, then this button will remain inactive.
- **New record**: add a new record to the current dataset. This button is only present when you are working in a dataset or in a database that is not subdivided into datasets.
- **Delete record**: delete only the current record from the data file, and ignore other possibly marked records. This button is only present when you are working in a dataset or in a database that is not subdivided into datasets. Adlib will ask you for a confirmation before a record really is deleted. You cannot undo a delete.
- **AND**: reduce the current selection using an AND search (see chapter 9).
- **OR**: expand the current selection using an OR search (see chapter 9).
NOT: reduce the current selection using a NOT search (see chapter 9).

Mark record: mark the selected record. This button is ‘pressed in’ when the record is marked (see chapter 15).

Toggle marks: mark all unmarked records and unmark all marked. (See chapter 15).

Remove all marks: delete all marks (see chapter 15). This button is only active when there are marked records.

Print: open the Print wizard dialog for the current record (whether this is marked or not). So, in the detailed display this button is always active. Other marked records will not be printed. (Also see chapter 16).

View selection: click this button to browse only the marked records; do not click it if you want to browse all records. When you are browsing through the marked records in the detailed presentation, then click this button again, and in the list screen only the marked records will be left.
This function is only available when records have been marked.

Information: context-sensitive Help for the active (selected) item.

Images in the Image viewer
In Adlib Library Lite, images can be linked to records.

When a record contains one or more images, those images will be shown in the Image viewer during the detailed presentation of a record (see Figure 10.3). So the Image viewer is always automatically opened if you display a record that has a linked image, or when you add such a link to a record.

To show images, Adlib uses a Microsoft DLL (a collection of procedures), which is a standard Windows feature. The Image viewer can display the following file formats: jpeg, tiff, bmp, gif, png, wmf, emf, icon, and exif.

You can link more than one image to a record. By default, a minimised image of the first occurrence is shown on the Normal tab in the Image viewer. Then use the arrow keys in the Image viewer to jump (from left to right) to the first, the previous, the next, or the last image.
Presentation screens and buttons

You can also zoom in or out, delete the current occurrence (when you are editing the record), or maximise the Image viewer itself, by clicking the Windows button Maximise (second button in the top right of the Image viewer).

You can also drag this window to another size, like you can with all windows. The location and size of the Image viewer on opening a screen are set originally during the design stage of a screen. The Image viewer is then visible only on that particular screen when you open the application for the first time. Changes in the dimensions and location of the Image viewer, made by the user*, will be stored by Adlib per database for the next time, even after closing your Adlib application. (Only a maximized Image viewer is not remembered by Adlib that way, but still in its previous size.)

* You change the position of the Image viewer by dragging its title bar to a different position, whilst you change the size of it by moving the mouse cursor over a border of the Image viewer until a double arrow appears, and then dragging that dimension greater or smaller.

Moreover, you can let the Image viewer appear on each tab of a detailed presentation on the same location and with the same size, by clicking the Pin image button in the Image viewer:

Click that button again to let the Image viewer only appear again on the screens that were designed to hold it.

When you have closed the Image viewer, you can reopen it by switching screens, or by clicking the underlined Identifier (URL) field.

In the Image viewer you’ll find the following buttons:

- Zoom in.
- Zoom out.
- Back to the window-size presentation of the image.
- First image.
- Previous image.
- Next image.
- Last image.
- Remove the link to this image from this record.
- Display the Image viewer on each screen.
- Rotate the image clockwise
- Rotate the image counter-clockwise

The Thumbnails tab gives an overview of all the images linked to this record in an even smaller size. Click one of the small images to display it on the Normal tab. Maximise the Image viewer window to display the image enlarged.
The Filmstrip tab actually combines both the other tabs. Click a miniature image to view an enlarged version right above it (if necessary, enlarge the Image viewer itself first).

Other functionality:

- Zooming in on the image happens with 10% per click. The height/width ratio will always remain the same as in the original. If the image is too large to fit in the screen, scroll bars appear that will let you view the rest of the image.
- If you print from the Image viewer (via the printer button), then the image is printed to fit centred on one page.
- If you are editing a record and linking a new image, it will be displayed in the Image viewer immediately.
11 Entering, editing or removing records

11.1 Entering a record

After you have selected where you want to work (probably books), click the New record button or choose Record → New record to open a new record for entering data. One database can hold up to 5000 records.

The different fields in a record have their own entry conditions: some fields are required, some are not, and in some you can enter several lines of text whilst others require a number in a specific format. Detailed information on fields and examples of their contents can be found in the contextual Help (see chapter 6.5) or right-click an entry field and choose Properties in the pop-up menu that opens to view the technical properties of the field.

The tag, the data type and possibly the validation type of the field that currently holds the cursor can also be read from the status bar, in the right lower corner of the Adlib window - if only the data type is mentioned, then the field is not validated. (See chapters 13 and 12.1 for more information about validation.)

11.1.1 Special buttons for entering or editing data

Append occurrence beneath: add a new occurrence beneath the current field. Note that this button, and the four buttons below, is only active if the cursor is in a field that can be repeated and a lot of fields cannot be repeated.

Append occurrence above: add a new occurrence above where the cursor is now.

Delete occurrence: remove the current entry field occurrence.

Add occurrence below: add an occurrence at the bottom of the list.

Empty field: remove all text from this entry field.

Find file: create a link to a document outside Adlib, for instance a Word document, or a URL (reference to an internet page). This button is present for e.g. the Library book field digital_reference.

Click this button to open the Select file window, in which you can look for the desired file in the usual way. When you find the file you want to link, select it and click the Open button. The file name (or names in multiple occurrences) in this kind of field will be underlined after saving the record. From display mode you can open the file in the associated program by clicking the link; from edit mode, use Ctrl+clicking to open the file.

Further, make sure that the files you link are on the network, because other users probably won’t always have access to your own hard disk.

Finding image file...: create a link to an existing digital image. This button is only available when you use images in your application, for instance for the Identifier (URL) entry field in the Visual Documentation database in Library Lite.

Click this button to open the Find image window, in which you can look for the desired file in the usual way. When you find the image you want to link, select it and click the Open button. The file name (or names in multiple occurrences) in the image field will be underlined after saving this record. The image will appear in the Image viewer in the detailed display of this record.
11.1.2 Working with occurrences
When entering data, you can use Tab to move to the next field, and Shift+Tab to go to the previous field. After entering text in a field, also press Tab to close this line and go to the next field: here, Enter has no function. Adlib will automatically move the cursor to the next line (within this occurrence) if you reach the end of the current line. If you want to lay out the text in an occurrence as separate paragraphs, then use Shift+Enter to go to the next line. (Also see chapter 6.4.2).

To add multiple occurrences of a field, e.g. several authors, press Ctrl+Enter. To delete an entire occurrence, click the Delete Occurrence button. To remove the contents of one entry field from a group, use the Empty field button. You’ll also find these options in the Edit menu.

11.1.3 Copying and pasting fields
The standard Windows cut, copy and paste functions are available, to move or copy text from one field to another, within the same record or outside of it. Select the desired text by clicking and dragging from beginning to end in a field, or press Ctrl+A to select all text in the field where the cursor is. Copy or cut the text via Ctrl+C or Ctrl+X respectively, place the cursor in the field in which you want to paste the text, and press Ctrl+V. (Press Ctrl+V again to paste the text again.) Only when you copy or cut a new text, the other text will be removed from the Windows clipboard.

11.1.4 Entering special characters
Adlib is a Unicode database which means that you can enter characters from languages like Hebrew, Chinese, and Greek in your Adlib records, and that the alphabetic sorting and searching of terms complies with the language characteristics of your region or country. So for the registration of, for example, a foreign language book you can enter the text in that foreign language into the Adlib record.

In most Windows applications, including in Adlib, you can enter letters with diacritical characters by first typing the diacritical character and then the vowel.

Each character also has a code. Keep the left Alt-key pressed and type (on the numerical pad of your keyboard) the 4-digit code representing the desired character. For example in the Windows: Western character set: press Alt and type 0128. The euro character € will appear. Other often-used codes are: Alt+0153 for ™, Alt+0169 for ©, Alt+0174 for ®, Alt+0177 for ± and Alt+0233 for ℓ.

You can set a character set in Windows through Start → Programs → Accessories → System tools → Character map. The drop-down list Character set, which shows after you mark Advanced view, shows the sets currently installed on your computer (the character set Windows: Western is the same as WinLatin1). For Unicode, select a Font because different characters are available for different fonts. Select any character to display the code of it (if there is one) in the lower right in the status bar of the window.

In this window, you can Select and Copy one or more characters and then paste them into Adlib (in a Unicode database) or somewhere else into a document. This way you can enter foreign characters with your western keyboard.

11.1.5 Finishing an entry
Data will not be saved definitively until you click Save (or Restart, Back or Record → New record). Adlib will ask whether you want to save the changes. If your answer is Yes, Adlib will update all the indexes and you will be able to search on the new or changed data immediately.

Instead of Record → Save you may also use the familiar Windows key combination Ctrl+S to store a record. Adlib will ask for confirmation as usual, before the record is actually saved.

11.2 Editing an existing record
You can change (edit) and remove records. Select a record you want to edit and in the list screen or detailed presentation click the Edit record button or choose Record → Edit in the menu. Click in an entry field of your choice and change the contents. When you are finished editing, click the Save record button. Adlib asks for confirmation. Click Yes to save, click No to close the detailed presentation without saving the changes you made, or click Cancel to continue editing the record.

11.3 Deleting one or more records
On the Brief display or detailed presentation (when it’s not in Edit mode), you can remove one or more records from the database. Adlib will ask for confirmation before permanently (!) deleting the record(s).
**From the Brief display**

In the Brief display click the *Delete record* button or press **Del** to remove a selected (highlighted) record or all marked records (with a checkmark in front of them) from the database.

Adlib asks for a confirmation before the current record really is deleted.

![Confirm deletion](image)

**Figure 11.1**: Confirm that the currently selected record must be deleted.

Be careful with deleting records. You cannot undo the removal of records.

If records have been marked, then first you will be asked which records have to be deleted.

![Delete options](image)

**Figure 11.2**: Choose to remove all marked records or just the currently selected record.

As soon as you click **OK**, the chosen selection will be deleted.

**From the detailed display**

Click the *Delete record* button or press **Del** to delete only the current record from the data file, and ignore other possibly marked records. This button is only present when you are working in a dataset or in a database that is not subdivided into datasets. Adlib will ask you for a confirmation before a record really is deleted. You cannot undo a deletion.
12 Extra functionality for data entry

12.1 Linked fields

A number of fields are linked to another file. That means that the data for certain fields will be retrieved from a different database. This creates a number of extra possibilities.

12.1.1 Term validation

A linked field may or may not allow you to add a term that the system does not know depending on how your application has been set up. The term is checked when you leave the occurrence. If the term cannot be found, and you are allowed to add terms, then you may add (sometimes called forcing) the entered term to the appropriate term index and to the linked file, or you choose a different term from the list and click Ok.

In Figure 12.1, Rowling, J.K. has been entered in the Author entry field. Leave the field and in the Linked record search screen that opens, you'll find a selection of all previously added authors of which the name starts (as much as possible) with the same letter, in the List of found keys. Author is a domain within the linked file Persons and institutions. Mark the Display terms in all domains option to display a selection of all indexed terms (of which the term starts with the same letter) from all domains in the linked file, so for instance also person keywords, printers and publishers. The names from the domain that belongs to the current field (in this case authors) will be displayed in bold type.

This check simplifies data entry and prevents terms being saved with different spellings or spelling mistakes.

Click the Show... button to display detailed information on a selected record from the linked file, in a zoom screen.

With the New record button, you can directly add a new record to the linked file, for the Search key you provided, and fill in details on the new thesaurus term. In the example of Figure 12.1 you could add personal details or a pseudonym for this author.

So, via the Add term button you could confirm that Rowling, J.K. should be added to the linked file. This name will not be saved in the catalogue record itself, but in the linked file (Persons and institutions in this case). In the catalogue record a reference to the linked file (the record number) will be included. ‘Added’ terms are only added to the linked database when you save the record. This prevents Adlib from having added records to the linked file already when you would decide not to save a newly filled record.
Extra functionality for data entry

When you click OK in the example above, the selected term (the one marked with a beige or blue bar), Roxburgh, William, 1751-1815, will be copied to the Author field, not Rowling, J.

When the cursor is in a linked field, in the toolbar the List button is active:

Click it to request a list with a selection of available keys for the current field. The Linked record search screen opens. The keys in the selection displayed start as much as possible with the same letter(s) as the search key you entered starts; for an empty search key the beginning of the index will be shown. You may type something else in the Search key entry field and the list will be updated accordingly. Select a key and click OK, to choose that term. Any linked data to this key is copied to the automatic fields (merged fields) of the catalogue record.

You can also check the data in the list or edit it. Click the Show button to display the data of the selected record in the linked database. Adlib displays this data in a zoom screen. If you have called up this zoom screen from a detailed presentation in which you were editing data, then you can also edit data in the zoom screen. With an opened zoom screen choose Record → Edit or when editing a record, place the cursor in a linked field, type a new term and click the Make/edit linked record button; you now create a new record in the linked file.

12.1.2 Automatic fields (merged fields)

Some fields are defined in such a way that they are automatically filled on the basis of the value in a key field. If you change the value in the key field, the automatic field will also change. For example, the type and format fields can be automatically filled in based on the digital image reference. You can then change the digital image reference field but not the automatic fields.

The data for an automatic field is retrieved from a linked database. The key field that has been filled in is used as the search key for the linked database.

12.2 Deriving records

Deriving records from other databases or datasets is useful when you are describing documents that contain similar data. An Adlib application builder can enable this option by creating a ‘similar’ or ‘friendly’ database, from which records can be copied. (It’s possible to have more than one friendly database.) A friendly database may be a local database, but may also be an external source which has to be approached over the internet. In Library Lite 3.4, for the Books dataset, the following external sources are available:

- Koninklijke Bibliotheek (Royal Dutch Library)
- British Library
- Library of Congress
- German National Bibliography
- Gemeinsamer Verbundkatalog (GVK - German)

You can call up or derive a record when you want to create a new record for a document (or when you want to update an existing record) for which you need that data. The Derive record command can be found in the Record menu. So, in the submenu, five friendly databases are offered; choose the external source from which you wish to derive.

For example, to derive a record from the British Library, you open the Books dataset, choose Record → Derive record → British Library to open a search form with which you can search in the external source. The search result will be shown in the Search result for deriving window. Click Show to display a record from the British Library, and click OK to copy the data from that record to a new record in Books.

When you have an existing record in edit mode, then for deriving data from another record you will be asked first whether the current record may be updated. If so, the fields from the external record will be copied to overwrite the fields in the current record. If not, a new record will be created in which the data from the external record will be copied.
13 Authority files

An Adlib authority file is a validation file, linked to one or more fields in other databases. Such a file contains all possible values for those fields. The advantage of authority files is that faulty input in other files can be kept to a minimum. During input or editing, a list of previously entered terms can be retrieved for some fields. A term from such a validated list can be copied to the new record or to the record to be edited.

13.1 Entering data

The examples discussed below use the Thesaurus file because a thesaurus may contain all possible relationships, but when applicable the relations also apply to other authority files.

13.1.1 Fields and their relations

For each field its purpose will be described, as well as how the relationships reappear in other records.

- **Term/Name**
  
  This is the keyword itself. This is an indexed and mandatory field. It must be unique within this file.

- **Term type/Name type/domain**
  
  Domains are a built-in feature of the Thesaurus and the Persons and Institutions files. These will be discussed extensively in chapter 13.2.

- **Notes**
  
  Definition and/or scope of the term plus any other comments you need to enter.

13.2 Domains (term type and name type)

Domains appear in the Thesaurus as Term type and in Persons and Institutions as Name type. The use of domains creates different sub-files. One or more domains can be linked to a single term or name. For instance, the thesaurus term “photograph” can fall into two domains: subject term and reproduction type (used in Visual Documentation). The domain determines the term or name type. Examples of types of terms are: Keyword, Geographical keyword, Language, Classification, etc. and of name types: Author, Person keyword or Publisher. One of the benefits of using domains is that in the Thesaurus for instance, different types of terms can be stored, while terms are still carefully validated.

If you enter a new book into Full catalogue: Books, and you enter a subject term and leave the field, or when you click the List button whilst the cursor is in the entry field Subject term, the Linked record search screen will open with only the relevant part from the linked thesaurus, namely all the terms from this file with term type or domain keyword.

In the Linked record search screen you’ll also find the Display terms in all domains option. Mark this option to display terms from all the domains present in the Thesaurus. The terms from the domain that is linked to the current field will be shown in bold type (see figure 13.1). You may also choose a term from another domain, to enter in the current field. When saving this record, the new domain will be added to the term in the Thesaurus. For instance, if you enter a material such as ‘China’ into the Subject Term field, and you save the record, then the authority file record for that term in the Thesaurus also changes; in the Term type field a second occurrence is added with the value keyword (The first occurrence remains geographical keyword). So ‘China’ would have two Term types: geographical keyword and keyword (subject term).
Figure 13.1: Showing terms from all domains. Domain terms are in bold.

**Searching on domains**

In (from within) the authority files themselves you can search on domain with the access point *Term type* or *Name type*.

13.2.1 Field validation

When you have created or modified a record in an authority file, Adlib will ask if you want to save the record. If you confirm, Adlib will check the information entered in the fields. In the event of an error, a message will be displayed. You can then make the required corrections and try to save the record again.

If everything is in order, Adlib will ensure that all the relationships between terms, are checked, updated or created. This may take some time. The catalogue is also updated.

The validation procedures are as follows:

- The *Term* must be filled in.
- The *Term* must be unique.

13.3 Switching to linked records

If a *Thesaurus* term has related terms (those are then underlined), you can switch directly to the corresponding record by clicking the underlined term. (Also see chapter 10.2.)

13.4 Deleting records

When in a brief or detailed display of the *Thesaurus*, you can delete a term record by clicking the *Delete record* button or via the *Record* → *Delete record* menu.

By default, Adlib does not check whether the term is in use in the catalogue, and whether there are any relationships with other thesaurus terms, and just removes the record. This may lead to corruption of the catalogue. Therefore, always first search and replace or delete the concerning (references to the) term everywhere in the catalogue, before you remove the term record in the *Thesaurus*. 
13.5 Printing

Thesaurus builders and users alike may find it useful to have a printout of all the terms and their relationships in the Thesaurus.

You can obtain such a printout as follows:

1. Select the Thesaurus file in the database menu (when present), and click Next.
2. Select Term, click Next and do not enter a value. Click Next again.
3. Click the All keys button and mark all records in the Brief display via the Toggle marks button.

4. Finally, click the Print button.

5. In the Print wizard, mark the Create a report with a predefined output format option, and click Next.
6. Choose the output format:
   - Thesaurus listing. This list displays information for each term.
7. Click the Finish button, and in the Print window the OK button, to actually start printing.

13.6 Thesaurus use from the catalogue

The Thesaurus file in the Library Lite application is used for the input of new subject terms, geographical keywords, languages etc.

13.6.1 Input

You can fill and maintain authority files from the file to which it is linked.

When you enter data in an Adlib record, the presence of the List button indicates that the cursor is in a field to which an authority file is linked.

You can search for, add, consult, and edit linked records from this field.

Click the List button when entering a Subject term to call up an alphabetical list of existing keywords. If you had already entered a few letters in the field, the list will begin at, or as close as possible to, the word or part of a word that you entered. You can move up and down the list in the Linked record search screen using the scroll bar and the arrow keys.

If you don’t want to enter a new keyword, choose an existing keyword by selecting it and clicking OK. Now, the keyword will be imported (copied) in the Subject term entry field.
14 Sorting

Search results in Adlib can be sorted by clicking on the *Sort* button in the toolbar of the *Brief display*. Adlib will now open the *Sort* window, in which you can set how sorting must take place.

![Sort window](image)

*Figure 14.1: You can set three sort parameters per field.*

The list on the left is a list of fields on which you can sort the records. You can only choose field names in bold type. In the *Sort field properties* list, you can see the fields on which sorting will be done and the field-specific settings that Adlib takes into account while sorting.

In the *Sort ADAPL* entry field you could enter the path and name of an ADAPL program that should handle the search result first.

### 14.1 Sort field parameters

**Field**

In the *Key* list in the *Sort* window you’ll find all fields on which you can sort (in bold type). The fields you actually want to sort on should be copied to the *Sort field properties* list on the right.

Double-click a desired field to copy it the sort selection, or select a field and click the arrow button pointing to the right. This way you can add several fields to the selection.

The order in which selected fields appear in the *Sort field properties* list, is the one in which Adlib will sort. When you add the next field to a selection, it will be inserted below the field that is highlighted in the selection.

To remove a field from the sort selection, you select it in the list on the right and click the arrow button pointing to the left, or press **Delete**. If you want to rearrange the order of the selection, you first remove the appropriate fields, and then reinsert them in the right places.

**Occurrences**

Here, you can indicate whether account has to be taken of only the *First* or of *All* the occurrences of a field within a record during a sort. In the latter case, Adlib will look at the record separately for every repeat of a field. A record may therefore occur more than once in the list.

Click the setting (the word *First* or *All*) and a drop-down list opens in which you can choose the other option by clicking it.

**Type**

The type of sort is normally determined by the index type of the sort fields. If there is no index for the field, the type that you select here will apply (*Text / Numeric / Date*).
Sorting

Click the setting (the word Text, Numeric or Date) and a drop-down list opens in which you can choose one of the other options by clicking it.

When you sort dates or numbers as Text anyway, then 111 will come before 2 and 01/02/1999 before 06/05/1970, which is probably not what you want.

- **Order**

Here, you can state whether the sort should be in Ascending order (0...9, a...z, from top to bottom on the screen) or Descending order (z...a, 9...0, from top to bottom on the screen).

Click the setting (the word Descending or Ascending) and a drop-down list opens in which you can choose the other option by clicking it.
15 Marking records

The marking of records is used to print or delete records, but also to refine the selection further or to export records.

In detailed display you can mark records by clicking the Mark record button or by selecting the Mark record command from the Mark menu:

In the brief display, you can mark a record by selecting the check box to the left of the record. Click that check box or the Mark record button again to unmark a marked record.

Clicking the Toggle marks button marks all unmarked records, and unmarks all marked records:

All marks are automatically removed when you open another file; all marks can be removed manually, by clicking the Remove all marks button:

Choose Mark → Keep marked records or press Shift+F3, to keep all the records that you have marked and remove the rest from the selection in the brief display.

When you have marked one or more records, the following button will become active in the toolbar:

In the brief display screen, click the View selection button to open the first marked record from your selection in detailed display. In detailed presentation click this button again to return to the selection; only the marked records remain in the selection.

In the detailed display of a record from the selection, you can browse through the other marked records and/or edit them via the following buttons:

■ Printing marked records

From the Brief display, click the Print button to open the Print wizard dialog for all marked records. (From within the detailed display of a record you may also start the Print wizard, but then you’ll only print the currently displayed record.)

See chapter 16 for more information about printing.

■ Exporting marked records

From the Brief display choose File > Export to export all marked records. (From the detailed display you’ll only export the currently shown record.)

See chapter 17 for more information about exporting.

■ Deleting marked records

From the Brief display, click the Delete record button to remove all marked records from the database:

Before deletion, Adlib will ask for confirmation (see Figure 15.1). The removal of records is permanent: you cannot “undo” a delete.
Figure 15.1: Do you only want to remove the current record, or all marked records?

See chapter 11.3 for more information about removing records.
16 Printing

16.1 Print wizard

The Print wizard is a very comfortable and simple way of printing. Open the Print wizard with the Print button:

If you click this button from the detailed display of a record, you’ll only print the currently shown record (whether that record is marked or not). If, on the other hand, you click this button from the Brief display, then you’ll print all marked records; the button will become active here after you’ve marked at least one record. (See chapter 15 for more information about marking records.)

![Print wizard screenshot]

Figure 16.1: Choose your printing method.

You can open the same assistant via File > Print, or through the key combination Ctrl+P.

Individual or marked records can be printed with an existing output format.

The order in which records will be printed is that in which they are listed in the brief display. If you prefer another order, then you must first sort the records (see chapter 14).

16.2 Windows settings for printing

After finishing the Print wizard (also when you have selected an output format), the standard Windows Print window will open, so that you can select a printer and change other standard settings before actually printing.

In the Print window you mainly determine the destination of the printout.

**Printer and Properties**

In the Name drop-down list you can select another printer that is connected to your system. Open the list and choose the desired printer by clicking it.

Click the Properties button to set up the properties of this printer. The Properties window varies per printer, but here you can, for example, set whether you want the orientation of the printout in landscape or portrait, and whether you want to print on one side or on both sides of the paper.
Print to file

Mark the *Print to file* option if you don’t want to print to the printer but to a file, meaning: if you want to save the data to be printed in a file. Such a print file is useful if you want to be able to make the same printout again quickly at some later time, or when users at other computers must be able to make the same printout.

After marking this option, click *OK* to create the print file. In the *Select an output file* window choose the folder in which you want to save the file, and in the *File name* entry field type the name for the print file. Also choose an extension for the file; the extension *.out* is no different from *.txt*, but files with the *.txt* extension can be opened automatically in text editors. Then click *Open* to actually create the file.

If you choose an existing file, you will be asked if you want to overwrite the existing file. If you select Yes, Adlib will overwrite the information that is already in the file. If you select No, the new output will be added to the end of the existing file, separated by a page-break.

Adlib will make a plain ASCII file in which the page transitions are included as form feed signs (hexadecimal: FF). In Windows text editors though, this changes into a small square, and page-breaks will not be forced that way.

The print file may be opened in, for instance, Windows Notepad or Microsoft Word to edit its contents. Then you can edit the contents as well as the layout of the document. Use the *Print* function in the relevant text editor to print the file at a later stage.

If you do not edit the print file but still send it to the printer from within a text editor, then the output will be the same as when you would have printed directly to the printer from within Adlib.

You can’t print images to a file via a print adapter, because this produces a simple text file.
**Send by e-mail**

To send the printout as e-mail text to one or more e-mail addresses, so that the recipients can print it to a printer themselves, mark the *Send by e-mail* option and click OK. The *E-mail addresses* window opens. Fill in the desired e-mail address(es) and click OK to send the printout.

![Image](image1.png)

Figure 16.3: Sending a printout by e-mail.

In the *Subject* entry field you can enter text that will be visible in the subject of the e-mail. That is the header with which an e-mail is denoted in an e-mail program.

Above it you’ll find the *To...* button*. Instead of entering e-mail addresses manually, you can click *To...*, to access the address book of your e-mail program.

If your e-mail program is MS Outlook, the *Address book* window opens.

![Image](image2.png)

Figure 16.4: Choosing e-mail addresses from the address book.

Double-click the desired names in the list on the left to copy them to the list on the right. When you have collected all desired names this way, click OK.

The names you choose (representing e-mail addresses) are now listed in the *E-mail addresses* window. If necessary, you may insert additional e-mail addresses manually (separated by semicolons).
Click OK to send the e-mails.

* Note: the To… button only appears if a MAPI e-mail program is used on your computer, such as MS Outlook. If the button remains absent, you’ll have to enter the e-mail addresses manually.

**MS-DOS text**

This option allows you to print results with the OEM character set, which is the character set used by DOS. This is useful if you want to import the output into another application that can only read DOS text and does not use the WinLatin-1 character set.

**Number of copies**

Here, you can state how many copies of the text are to be printed.

**Preview**

By clicking the Preview button, you can view the printout on screen before actually printing and it will look exactly the same as it will look on paper. (Click the Close button to close the print preview screen and return to the brief or detailed display.)

Click the Multiple pages button and in the menu that opens choose the number of pages that you want to view in the screen at the same time: the maximum is 2x3. In the print preview the mouse pointer changes into a magnifying glass. Click the text to zoom in and click again to zoom out. If you display multiple pages at the same time, you can use the magnifying glass to zoom in on any displayed page; with the magnifying glass click the page you want to view up close, and click again to return to the multiple pages display.

Click the One page button to quickly return to the preview of one page.

Finally, click the Print button to send the print job to the printer.
17 Importing and Exporting

You can export and import data in different file formats in Adlib Library Lite. The Export option in the File menu can be used as soon as one record is being displayed in the detailed presentation (marked or not) or when multiple records have been marked in the Brief display: so either only the currently shown record will be exported, or all marked records from the Brief display. The Import option in the same menu is only available just after you have chosen a database or dataset in the Search wizard.

The settings you make in Adlib applications (based on Adlwin) for import and export jobs, can be saved as a parameter file (in XML-format), so that you can use the same profile for the same type of job later instead of having to make all the settings again.

As soon as you start the Import or Export wizard, the first window that appears offers the possibility of opening profiles you saved earlier. Click the Browse button to find and open the desired profile. Parameter files have the (double) extension .imp.xml or .exp.xml. The settings are automatically copied to the next page of the wizard, and you can modify them before you start the actual import or export.

The last page of the wizard offers the possibility to save your settings, so that you can quickly retrieve them at another time. You have to explicitly save them yourself. This is not done automatically.

17.1 The Export wizard

The Export wizard has three pages for the three steps of the export process (see Figure 17.1).

Page 1

Here you select the method of exporting: an Adlib tagged file, a CSV (comma separated values) file or an XML file.

Here you may also open earlier saved export settings via a parameter file.

- **Adlib tagged file:** the result of this method is a list of tags followed by a space and the field value. In case of repeated fields the tag is repeated for each occurrence. The records are separated from each other by asterisks, and by default the first tag is the record number; for a selection of objects for example:

  %%0 29

  ui Hutchinson

---

**Figure 17.1:** Choose an export format.
Object ID Template

**ti Ode less travelled: Unlocking the poet within**

**ju 2005**

**au Fry, Stephen**

**tr Poetry**

**tr education**

**%

**ui Bloomsbury**

**ti Harry Potter and the Deathly Hallows**

**ju 2007**

**au Rowling, J.K.**

**

Listing 17.1: Two records with a repeated field, exported as Adlib tagged file.

- **CSV (comma-separated values):** only the first occurrence of a field is exported and different fields are separated by a comma. This method of exporting is not suitable for repeated fields. The entire list is preceded by an enumeration of the field names. Values and names are in between double quotes; for an object file for instance:

  "author.name","title","publisher","year_of_publication","keyword.contents"

  "Fry, Stephen","Ode less travelled: Unlocking the poet within","Hutchinson","2005","Poetry"

  "Rowling, J.K.","Harry Potter and the Deathly Hallows","Bloomsbury","2007",""

Listing 17.2: Two records with a repeated field, exported as CSV file.

- **XML file:** the selected fields of a record are exported to a file in XML (Extensible Mark-up Language) format. The field name as recorded in the data dictionary, for instance title, is used in the following way:

  <title> Monteverdi and his contemporaries </title>

(Monteverdi and his contemporaries is an example of a title.) With XML you can export data in a structured form, which is useful for exchanging data.

An XML file does nothing of itself. With style sheets (layout forms) you can edit an XML file e.g. for presentation purposes or use it in another database application. Example:

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<recordList>
  <record>
    <title>Ode less travelled: Unlocking the poet within</title>
    <author.name>Fry, Stephen</author.name>
    <publisher>Hutchinson</publisher>
    <year_of_publication>2005</year_of_publication>
    <keyword.contents>Poetry</keyword.contents>
    <keyword.contents>education</keyword.contents>
    <priref>1</priref>
  </record>
  <record>
    <title>Harry Potter and the Deathly Hallows</title>
    <author.name>Rowling, J.K.</author.name>
    <publisher>Bloomsbury</publisher>
    <year_of_publication>2007</year_of_publication>
    <priref>408</priref>
  </record>
</recordList>
</adlibXML>
```

Listing 17.3: Two records with a repeated field exported as an XML file.

Each of these export results can be opened and viewed in a text editor like Windows Notepad.
Here (see Figure 17.2) you select the fields you want to export. In the left part you can click on one or more fields and use the arrow pointing to the right to transfer the field to the right part. With the double arrow pointing to the right you can transfer all the fields from the Select fields list to the right part in one go. (These might not be all the fields in the record!) If you make a mistake, you can use the arrows pointing to the left to remove fields from the list on the right.

**Export all fields in a record**

It is also possible to export all record fields, even those that are invisible in the Export wizard field list. (Fields that have not been defined in the data dictionary do not appear in the field list.) Mark the Export complete record option to be sure that all fields will be exported. The exception to this rule is exporting to csv. When you export records to a .csv exchange file from within Adlib via the Export wizard, and in the second window of that wizard you mark the Export complete record option, then still only the fields that are defined in the data dictionary (the .inf file) will be exported. Database fields that have only been specified on a screen will not be exported. This is not a bug, but a limitation of the export functionality. The csv format contains a whole record on one line, with a fixed number of fields, even if they're empty. However, an Adlib database contains no empty fields. So to export a complete record, the export function looks at which fields have been defined in the data dictionary, and fills them with the aid of the database, but it doesn't check the records for other possible fields. Fields that haven't been defined in the data dictionary, which are not temporary fields, occur incidentally. If you do want to export such a screen field to csv, then define the relevant field in the data dictionary first.

Figure 17.2: An example taken from books, exporting only a few fields, all fields from the data dictionary or all fields from the record.
On the third and last page of the Export wizard you can choose a file to which you want to export. Click the upper Browse button to select an existing file (to overwrite it) or to enter a new file. In the latter case, enter a name for the file and click Open.

You can save the settings you made in this wizard for a later time, by storing them in a parameter file. For this, use the second entry field: Save parameters to file.

Finally, click Finish in the Export wizard to start exporting.

### 17.2 The Import wizard

In Adlib you can import data from the Adlib tagged file and XML file formats, into the opened database or dataset.

1. In the Step 1 of the Search wizard, choose the database or the dataset in which you want to import data.
2. Choose File → Import to open the Import wizard.

3. Select the format in which the exchange file data is stored: Adlib tagged file or XML file. (See chapter 17.1 for a description of these formats.) Or open an earlier created parameter file with import settings. Click Next.

4. In the Select source file entry field in Step 2 of 3, specify the path to the exchange file from which you want to import data. Click Browse to search for the file on your system; the path to the file will automatically be entered in the entry field.

5. While importing, Adlib can check whether a record already occurs in the database and update it. To do this, mark the Update tag option and fill in the (indexed) field tag which is unique for each record (e.g. the record number tag %0). If you fill in %0 (= primary reference) for the Update tag property, Adlib will check whether each specified priref in the exchange file already exists in the database. If so, the existing record will be overwritten ("updated" as it were: filled in tags in the existing record(s) will remain, provided they don’t occur in the import file record). If you leave this option unmarked, Adlib will not check whether records already exist. The records in the import file will simply be added to the database. If you leave the Ignore record numbers option unmarked too, the imported records will be given the same prirefs (record numbers) as they had in the exchange file. Any existing records with the same priref will then be completely overwritten!
6. Mark the **Ignore record numbers** option if you want all records to be imported to receive new record numbers, for example to import previously exported datasets into another dataset without overwriting existing records.

7. For this import job, Adlib will create an import parameter file in memory, which you can save for a next time by providing a file name in the **Save parameters to file** entry field. The settings for this import definition are as follows:

   - **Source file** = <the source file selected by the user>. This should be in the same directory as the Adlib database in which importing takes place.
   - **Destination dataset** = <the destination file selected by the user>. This is the current dataset in Adlib.
   - **File format** = <Adlib tagged or XML, selected by user>.
   - **Update tag** = <mostly %0>. This option is used for overwriting existing records which have identical update-tag values as the records to be imported.
   - **Add new records** = Yes, by default. This way, records can in principle be added, instead of only replacing existing ones. This option cannot be set differently here in the **Import wizard**.
   - **Delete old tags** = No, by default. If existing records are to be replaced, then this setting leaves tags which are not imported as they are. This option cannot be set differently here in the **Import wizard**.
   - **Process links** = Yes, by default. This setting validates imported link references, or creates new linked records from term values in imported linked fields if those records do not yet exist in the relevant linked database. This option cannot be set differently here in the **Import wizard**.
   - **Clear database first** = No, by default. This setting makes sure the target database will not be emptied prior to importing. This option cannot be set differently here in the **Import wizard**.
   - **Tag list** = **-**>**, by default. All tags will be imported if the names of the source tags in the exchange file correspond exactly with the destination tags in your Adlib database. This option cannot be set differently here in the **Import wizard**.
   - **Counter** = 10, by default. The progress report of the import will be refreshed after every 10 imported records. This option cannot be set differently here in the **Import wizard**.
   - **Ignore record numbers** = <Yes or No>. Yes gives all imported records a new record number; existing records in the target database will not be overwritten.
   - **Input buffer size** = 32000, by default. The input buffer is memory space allocated by Adlib to read in data from the exchange file. This option cannot be set differently here in the **Import wizard**.
   - **Default wordwrap value** = 31999, by default. This is the maximum number of characters that can be imported into one target field occurrence. If there are more characters than this in a source field, then the surplus is put in a next occurrence of the field. This option cannot be set differently here in the **Import wizard**.
   - **Priref offset** = 0, by default. This offset specifies from which record number in the current database the records to be imported should be inserted. If to be imported record numbers won’t be ignored, they get the value of the record number from the import file plus the offset value. Existing records in the target database may be overwritten. This option cannot be set differently here in the **Import wizard**.

8. Click **Next** to start importing in **Step 3 of the Import wizard** and to add all records from the source file to the current database.

   You can observe the progress of importing, and any errors will be reported. The text that appears in the **Error report** box can be selected with the mouse and copied, to paste it in a text document elsewhere so you can save it.

   For more information on these options and the default settings, see the Adlib Designer Help downloadable from the Adlib website [http://www.adlibsoft.com](http://www.adlibsoft.com).
18 Customizing your toolbar

You can adjust the arrangement of the toolbar to your liking, to a certain extent. To do this you can use the functions in the Options > Toolbar submenu: you may change the order of the sub toolbars with respect to each other, you can shorten or lengthen sub toolbars (so that fewer or more buttons in them are directly visible), and you may place sub toolbars underneath each other in new toolbar lines. It is also possible to change the size of the toolbar buttons.

The changes you make to the toolbar will be saved under your login name, and therefore you will be the only one who will get to see this adjusted toolbar. All other users will be presented with their own toolbar (adjusted or not), even when they log in to your computer.

1. To begin with, choose Options > Toolbar > Lock if it has a green check mark in front of it, to unlock the toolbar; this is necessary if you want to be able to rearrange the toolbar. (When you are done with rearranging, you lock the toolbar again by choosing the same function.)

2. In an unlocked toolbar you’ll see vertical dotted lines to indicate the handles with which you can drag the sub toolbars to another spot.

![Drag handles](image)

Click it, keep the mouse button pressed down and drag to the left or the right to make the sub toolbar longer or shorter, for instance:

![Drag sub toolbar](image)

Drag a sub toolbar downwards, to place it on the next toolbar line.

![Custom toolbar](image)

From there you can drag such a sub toolbar back up again and then insert it at a different position in the order of the sub toolbars there.

3. You may also change the size of the buttons, through the Options > Toolbar > Icon size menu.

4. If you would like to restore the toolbar to its original state, then choose Options > Toolbar > Reset toolbar.
## Appendix 1: buttons in Adlib

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
<th>KEYS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Navigating and browsing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Return to the beginning of the application to choose another dataset.</td>
<td>F8</td>
</tr>
<tr>
<td></td>
<td>Step back to an earlier screen.</td>
<td>F7</td>
</tr>
<tr>
<td></td>
<td>Go to the first record in the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Go to the previous record in the list.</td>
<td>F6</td>
</tr>
<tr>
<td></td>
<td>End entry/editing and save the record.</td>
<td>F11</td>
</tr>
<tr>
<td></td>
<td>Start entry of data (editing).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Go to the next record in the list.</td>
<td>F5</td>
</tr>
<tr>
<td></td>
<td>Go to the last record in the list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Make settings for sorting the order of the retrieved records.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Entry, deletion and editing</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add a new record.</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td></td>
<td>Delete selected records.</td>
<td>Delete</td>
</tr>
<tr>
<td></td>
<td>Start editing or, if already in edit mode, stop editing and save.</td>
<td>F11</td>
</tr>
<tr>
<td></td>
<td>Stop entry/editing and save.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add occurrence (above selected occurrence).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add occurrence (below selected occurrence).</td>
<td>Ctrl+Enter</td>
</tr>
<tr>
<td></td>
<td>Empty this field.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete the selected occurrence.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Add occurrence at bottom of list.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Link to a document or application outside Adlib.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Link to an image.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Open the <em>Linked record search screen</em> to view the linked file for the current field.</td>
<td>Shift+F4</td>
</tr>
<tr>
<td></td>
<td>Edit data in the linked record.</td>
<td>F10</td>
</tr>
</tbody>
</table>
### Marking and printing

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
<th>KEYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Marking icon]</td>
<td>Mark the current record.</td>
<td>F3</td>
</tr>
<tr>
<td>![Invert marks icon]</td>
<td>Invert marks.</td>
<td>F4</td>
</tr>
<tr>
<td>![Limit list icon]</td>
<td>Limit the list to all marked records.</td>
<td></td>
</tr>
<tr>
<td>![Remove marks icon]</td>
<td>Remove all marks.</td>
<td></td>
</tr>
<tr>
<td>![Print icon]</td>
<td>Printing with the <em>Print wizard</em>.</td>
<td></td>
</tr>
</tbody>
</table>

### Image viewer

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
<th>KEYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Zoom in icon]</td>
<td>Zoom in.</td>
<td></td>
</tr>
<tr>
<td>![Zoom out icon]</td>
<td>Zoom out.</td>
<td></td>
</tr>
<tr>
<td>![Display original size icon]</td>
<td>Display image in original size.</td>
<td></td>
</tr>
<tr>
<td>![First image icon]</td>
<td>First image.</td>
<td></td>
</tr>
<tr>
<td>![Previous image icon]</td>
<td>Previous image.</td>
<td></td>
</tr>
<tr>
<td>![Next image icon]</td>
<td>Next image.</td>
<td></td>
</tr>
<tr>
<td>![Last image icon]</td>
<td>Last image.</td>
<td></td>
</tr>
<tr>
<td>![Remove occurrence icon]</td>
<td>Remove the current occurrence.</td>
<td></td>
</tr>
<tr>
<td>![Display image viewer icon]</td>
<td>Display the Image viewer on each screen.</td>
<td></td>
</tr>
</tbody>
</table>

### Combined searches

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
<th>KEYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>![AND icon]</td>
<td>AND</td>
<td></td>
</tr>
<tr>
<td>![OR icon]</td>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>![NOT icon]</td>
<td>NOT</td>
<td></td>
</tr>
</tbody>
</table>

### Online Help

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>DESCRIPTION</th>
<th>KEYS</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Help icon]</td>
<td>Context-sensitive help text.</td>
<td>F1</td>
</tr>
</tbody>
</table>
20 Appendix 2: Cataloguing your Library items

So far, this User Guide has taken you through the practical methods of putting data into Adlib and then how to find it again. Now we are going to consider some of the issues around what you are going to enter into the application and why certain fields in Adlib are best suited for certain types of data.

When starting to catalogue Library items there are a number of questions that should be asked and issues solved in advance of starting work. Any form of cataloguing can be intensive work and can require a significant input of resource, usually in time. The aim of any cataloguing project is to have records for all the items the project is covering. These records must be able to be found when searched for because, ultimately, data is only ever recorded so it can be found again, at some future time.

In this Appendix the term ‘project’ is used to signify a directed piece of work, whether it is cataloguing a library’s complete collection, cataloguing a discrete group of items or recording your own collection of books and ephemera. The term ‘item’ is used to represent a book, article, piece of audio-visual material (like a video or dvd), journal or other such unit of information which is to be recorded.

20.1 Recording or indexing

At the heart of any cataloguing process there are two end purposes for entering data into fields. These are for recording purposes and for indexing purposes.

Recording is the aim of accurately entering extremely precise detail about the item.

Indexing is to enter data about an item to aid finding that item again and so this may not necessarily be as detailed as in a recording field. Think of it like the index at the back of a book. Each entry helps you get back to the relevant page, and so an index field helps you get back to the relevant records although the index entry may not be absolutely, pedantically accurate.

In Adlib, some fields are designed with the idea of indexing in mind. These are usually controlled by lists such as Persons and Institutions and the Thesaurus. Examples of such fields would be author, publisher or language. Other fields are designed for recording and these are usually free text entry fields such as title or abstract.

20.2 Starting to catalogue from scratch

When starting to enter library items into a brand new system there is often a temptation to jump straight in and get on with it. However, it can pay to take a step back and think things through before entering data. Here are a few things to consider.

20.2.1 Consistency

The first rule for any system is that it does not matter what decision you actually make so long as you stick to that decision. Consistency is everything when computerising data.

If you have multiple recorders on your system then they must all catalogue using the same rules and in the same manner. If they are inconsistent, either by using different rules from another person or changing the rules used from record to record, then it will be harder for people to find records. It will also result in more work in the future when it becomes clear that the data needs to be cleaned up.

A good method of ensuring consistency is to create a ‘Manual of Recording Practices’ for your project. In this, it should consider each issue and state your project’s approach to it. When particular problems arise then these can be added into the manual for future reference.

20.2.2 Extent

On starting a project, it needs to be decided what will be covered. Initially, this will be in the form of what library items will be recorded. However, you do also need to decide upon what particular data about these items should be recorded. You need to consider the following questions:

- Is the quality of your data sufficient for every field to be completed?
- Is it worth completing every field or even the majority of fields?
- Is there a minimum amount of data that makes up a record?
- Do you need to touch the items when recording or are you taking your data from another source, such as an old card catalogue or deriving it from another organisation?
Questions such as ‘who is your target audience’ and ‘what sort of questions do you need to answer’ should drive what you decide to record. As has been stated before, the aim of cataloguing is to allow for the retrieval of records. Thus every cataloguer should be thinking ‘How will people look for this’ when dealing with every record.

### 20.2.3 Core Data

One answer to the questions raised about the extent of your cataloguing is to define a core set of fields that should be catalogued if you have the data. In most ADLIB applications the number of mandatory fields has been kept to a minimum. For instance, in a library application the only mandatory field is the title. This means that it is possible to create a record with only one field entered but this is not desirable. What you want to end up with is sufficient scope of data to answer the needs of your users.

Technically, it would be possible to set ADLIB up in such a way that lots of fields demanded data and that you would be unable to save a record without entering that data. However, what happens if a record does not have one of these pieces of data? The complete record could not be saved without this mandatory field being entered so one possibility would be to not record that item. Alternatively it would be possible to have a value in a field saying that there was no value but this seems pointless. The introduction of non precise data is potentially misleading to any user. This is not a good approach to employ.

A better approach is to state which fields are core to your recording strategy and then aim to complete these core fields whenever your data allows.

Once you have defined core fields you need to decide what to do if there is no data to complete a field. Should it be left blank, should you put a note somewhere, should you have a value indicating there is no value for this field?

### 20.2.4 Rules

Before you start cataloguing, you will have decided to what extent you are going to record items so next you need to decide how you are going to record this data in the individual fields. You need to set up policies or rules about the following issues and ensure these are included in your recording practice manual.

- **Case**
  - In ADLIB all searching is case insensitive so the case you choose does not affect searches.
  - In reports and on the Internet, ADLIB, as a default, displays the data in the manner in which you have entered it. So if it is entered in capitals then that is how it will be displayed. If this is not what you want, don’t enter it like that.

- **Pluralisation**
  - You need to decide if terms are entered in the singular or plural. Once you have made a decision stick to it.
  - Fields such as ‘subject term’ are intended as guides for retrieval to help guide a searcher to that particular record. This being the case, they are not intended to suggest quantity or certainty. Therefore, if you have decided on using the singular mode, stay with it even if a particular item record refers to more than one item. For instance, if you have chosen the singular mode enter dvd even if the record is for two dvds. If the record contains a historical place name you need to decide if you record the current name or the historical name or both. If the historical name is unclear or uncertain then do not record it as ‘Clarkenwell?’, your certainty can be recorded in a notes field. The more variations you have of one term (‘Clerkenwell’, ‘Clerkenwell?’, ‘Clarkenwell’, ‘Clarkenwell?’’, ‘Clarkenwell ?’ etc) the more searches have to be done.
  - If you have opted for the singular, exceptions can be made for plural nouns such as trousers or scissors, where current usage is only ever in the plural.

- **Dialect**
  - Decide upon an approach for dialect terms. Often they could be synonyms for a more common form; for instance holm oak for holly so you will need to decide which is to be used.

- **Abbreviations**
Particularly in the recording of names, elements of a name can be abbreviated in the original such as Ltd or Jos. It is usually best to enter words in full and avoid abbreviations where possible.

- Punctuation
  - Keep punctuation to a minimum wherever possible. It might be grammatically correct to punctuate exactly but this can lead to searching problems. The inclusion of fullstops and commas can alter the term for search purposes. The term 'knife.' is a totally separate term to 'knife' from a computer searching point of view. When looking for 'High Street, Swindon' you would need to include the comma if searching for the complete term. The more punctuation you put in the harder you make it for a searcher to find records. They will need to know precisely how you have punctuated a term and if they get one piece of punctuation wrong in their search then they would not find the record.

- Recording of names
  - You need to decide your policy on the recording of names. There are a lot of rules you can refer to for help in this. Libraries use the Anglo-American cataloguing Rules 2nd edition or Library of Congress Rules. Archives usually follow ISAAR(CPF), the International Standard Archival Authority Record for Corporate Bodies, Persons and Families or the National Council on Archives‘ “Rules for the construction of personal, place and corporate names”.
  - From a purely technical viewpoint, names in ADLIB usually use a term type of accesspoint and index. This being the case searching is usually set for right truncation, meaning that when you type in a term it will look for everything starting with that. Therefore, it is usually best to start with the surname since this will group all terms with that surname together. It also avoids the problems of different versions of the same surname (Elizabeth, Liz, Beth, Eliza, Elisabeth etc).
  - Decide on a policy for leadwords in company names. A company could be something like ‘The Cardboard Box Company’. Should you record the leadword ‘the’? In some instances the complete legal name might include this so that would indicate that it would be needed. Conversely from a computerisation sense you would end up with many records sorted by the word ‘the’ and not by the main sense of the name.
  - Consider how you will deal with two people with an identical name, for instance George Gilbert Scott.
    - Names must be unique so you would have to differentiate the different concepts for instance Scott, George Gilbert (1811-1878) or Scott, George Gilbert (1839-1897).
    - If you do not differentiate the different names then a searcher when looking for one particular person will find records relating to anybody with that name.
    - Entering biographical details for people can help direct the cataloguer in the manner with which to use the name. However, this does rely on the cataloguer actually bothering to read the biography.

- Spelling
  - Where you have a word or term that has alternate spellings using either ‘s’ or ‘z’ you need to decide upon one and stick to it. For instance, with a term such as ‘mobilisation of troops’ should it be mobilisation or mobilization?
  - Decide on a policy for terms which could be one or two words. Is it water mill or watermill?
  - Decide on a policy for hyphenated words. Is it water-ski or water ski?
  - It is usually advised to choose one dictionary and use that as the final authority on spelling.

- Multiple meanings to one set of characters
  - It is quite possible in English to have multiple meanings or concepts attached to a single word or term. For instance the word ‘bill’ could mean:
    - A written account of moneys owed
    - A list of events
    - Part of a bird (the same as beak so should one be a non preferred term of the other or should they be equivalent terms?)
    - Part of the fluke of an anchor
    - A type of polearm like a pike or halberd.
    - An abbreviation of billhook, a type of chopping tool.
  - Your collection will influence whether you are likely to have instances of the different items. If you are an archive, you are unlikely to have parts of an anchor!
  - Terms in authority lists must be unique so you would have to differentiate the different concepts for instance bill (financial), bill (polearm) etc.
  - If you do not differentiate the different concepts then a searcher when looking for types of polearm will find the natural history’s collection of bird bills or the archive’s selection of bills connected with finance and events.
  - Creating scopenotes for terms can help direct the cataloguer in the manner with which to use the term or any situations when not to use the term. However, this does rely on the cataloguer actually bothering to read the scope note.

- Depth of recording of terms
When recording items you have to decide how detailed your subject term or object name recording should be. If recording building materials would it be sufficient to enter ‘brick’ or do you need to identify the different types of brick such as ‘engineering brick’, ‘london brick’, etcetera? Or if you are recording medals in the object name field do you just want to state that it is a medal or do you want to define types of medal? Or if you are recording the subject terms of a book would a single term be sufficient or would you want multiple more detailed terms?

Some organisations severely limit the number of subject terms because “searching for terms will slow the cataloguing process down”. If this approach is used there are obvious benefits in the speed of cataloguing and also in the maintenance of the list since it is very limited. The big drawback is that any search will be finding a lot of records making it much harder for a specific searcher to find what they want. They will end up trawling through hundreds or thousands of records.

There is no easy guidance that can be given since it will vary from collection to collection and depend upon the subject matter being dealt with. However, always think of the end user, the person searching for this data, so think how they will search for it and whether you are providing enough detail, or too much.

20.2.5 Cataloguing Practice

When cataloguing an item, some of the fields provided by ADLIB are intended as an index to aid the searcher in finding the record and other records connected to the index term. In these, index-based fields such as subject term provide sufficient terms to help searchers find the record.

You can use ADLIB’s multiple occurrence functionality to add as many occurrences of the field as you feel necessary. You are not limited to a set number of entries, for instance, no more than three subject terms. In ADLIB you can have as many occurrences as you need.

20.2.6 Decision Making

When starting a project, you will need to make a decision about decisions. That is to say, who can decide what is an acceptable term and the process for accepting or refusing terms. ADLIB generally works in a very open manner allowing any cataloguer to add new terms to the authority lists. If you are working in a large project or in a project split across several applications you might decide there is a need to monitor new entries. It is possible to do this by searching on new terms created since a particular date.

Some organisations have a small group who meet up regularly to discuss the new terminology and to decide on whether to accept it, reject it, where to place it in the hierarchy etc. This approach does mean that there is much greater control of the terminology in use.

If you decide to leave the checking of terminology until later in the project, perhaps working under the premise of ‘let’s enter our records then we can see what terms we have got’, then you are likely to end up with a lot of clearing up work to do.

20.3 Starting to catalogue where there is existing data

Many projects will start by adding records into a database where there are already records. Some projects may be using ADLIB for the first time but there is data in the system already since it has been the subject of a data conversion.

The basic guidelines as stated above do not alter. However, the recording practice might already be established as seen in the contents of the existing records. This is not always the case because sometimes existing records display the results of differing recording practices.

If the recording practice you want to establish is remarkably different to that used in the existing records then you need to decide whether you leave those records as they are; start a second project of retro-active updating; or reassess your recording practice and stick with the original practice.

Following a data conversion from another system into ADLIB, the data in ADLIB may appear to be worse than expected. It is worth noting here that during a data conversion ADLIB does not alter or deliberately change your data. This effect is usually as a result of data being displayed in a different way to before and
Object ID Template

often in a more structured manner. For instance, with data taken from a Microsoft Excel spreadsheet where one column referred to subject then this data would display in ADLIB as a list. Lists in ADLIB are organised alphabetically and all the terms are strictly unique. It is probably the first time that all the subject terms have been shown alphabetically and Microsoft Excel does not enforce uniqueness so the different variations will appear. This is not unusual.
21 Index

delete .................................. 27, 28
line .................................. 65
record .................................. 66
Delete record .................. 58, 60, 67, 72
deriving .................................. 70
deriving records .................. 70
Descending .................................. 76
detailed display .................. 57
detailed presentation .............. 59
diacritical characters .............. 51
direct-detail .................. 72
Display terms in all domains 69, 71
domains .................................. 69, 71
double quotes .............. 53
double-clicking .................. 46

E
etit .................................. 18, 22
record .................................. 66
Edit record .................. 58, 60
e-mail .................................. 81
emf .................................. 61
empty field .................. 65
dnt key .................................. 53
entering data .................. 65
new record .................. 65
occurrence .............. 65
text .................................. 47
exif .................................. 61
exp.xml .................................. 83
export .................. 33
selecting fields .................. 85
viewing results .................. 84
Export complete record .................. 85
export profiles .................. 83
Export wizard .................. 83
exporting .................. 83

F
field
fill automatically .................. 70
linking to fields .............. 69
field validation .................. 72
fields
_duplicates .................. 47
_entry conditions .................. 65
_occurrences .................. 47
_file
_linking to fields .............. 69
_file formats .................. 61
_file menu .................. 39, 41, 49
_file selection .................. 49
Filmstrip .................. 63
Find file .................. 65
First record .................. 57, 60
free text .................. 53
friendly database .............. 70
function keys .................. 46

gif .................................. 61

A
accents .......................... 51
access points .................. 49
menu .......................... 41, 51
add
occurrence .................. 65
ADLIB
starting .................. 41
ADLIB tagged .................. 83
Adlib tagged file .................. 86
all keys .................. 53
All keys .................. 42
all records, select .............. 53
Alt key combinations .............. 46
AND .................. 15, 55, 58, 60
append occurrence buttons .............. 18
Ascending .................. 76
ASCII file .................. 80
authority file .............. 71
data entry .................. 71
data entry from other files .............. 73
input validation .............. 72
automatic
fill field .................. 70
automatic fields .................. 70

B
Back .................. 57, 60
backups .................. 43
bmp .................. 61
Brief display .................. 53
buttons .................. 57, 60
Brief display screen .................. 42, 57
button
List .................. 70
buttons .................. 45
Brief display .................. 57, 60
for combining .................. 55
greyed out .................. 58
list screen .................. 57, 60
rearranging .................. 89
tooltip .................. 46

C
change font .................. 59
change font size .................. 59
close .................. 45
combine searches .................. 15
combined searches .................. 55
concatenators .................. 53
copy .................. 66
CSV .................. 83, 84
Ctrl key combinations .............. 46
Ctrl-S .................. 66
cursor .................. 47
cut .................. 66

data dictionary .................. 85
database menu .................. 41, 49
Index

greyed out ..................................45

H
help ............................................47
contextual ....................................47
Help .................................. 58, 61
Help (F1) ....................................47
hide screen tabs ...............................59

I
icon ...............................................61
image ............................................22
Image viewer ....................................61
images ..........................................65
Images ..........................................61
import ............................................36
import definition ...............................88
import profiles ..................................83
importing .......................................86
index ...........................................51
date ............................................53
in Search wizard ...............................52
numeric ..........................................53
term .............................................52
word .............................................53
index key .......................................42, 51
term index .....................................52
indexing methods .............................51
Information ....................................58, 61
interrupt
a search .......................................52

J
jpeg .............................................61

K
key ...............................................42, 51
key combinations ..............................46, 47
keys .............................................52

L
landscape .......................................79
language selection ..............................48
language switch ................................48
Last record ....................................57, 60
link screen ......................................21
link to a document ................................65
link to an image ..................................65
linked field .....................................70
linked fields ....................................69
linked record
editing .......................................70
Linked record search screen ......................69, 70, 71
list .............................................20, 46
List ...............................................20
List button ......................................70
List of found keys ................................69
list screen ......................................53, 57
buttons ...........................................57, 60
lower-case ......................................51

M
magnifying glass ................................82
main menu .......................................41
Make/edit linked record ..........................70
mark record ....................................58, 61
marked records
viewing ..........................................77
marking of records ................................77
marking/unmarking ................................58, 61
marks
remove all marks ..................................77
removing ..........................................58, 61, 77
toggle marks ......................................77
maximize .........................................45
menus .............................................45
through keyboard ................................46
merged fields .....................................70
minimize .........................................45
mouse pointer ....................................47
MS-DOS text ....................................82
Multiple pages ..................................82

N
name type .......................................71
Name type .......................................72
new occurrence ..................................65
new record ......................................16
New record .....................................58, 60
Next record ......................................57, 60
non-truncated search .............................52
NOT ............................................15, 55, 58, 61

O
occurrences ......................................47, 66, 75
One page ........................................82
options .........................................59
OR .............................................15, 55, 58, 60
out ...............................................58, 60
output format ....................................80

P
page transitions ..................................80
paste .............................................66
Persons and Institutions ........................71
Pin image ........................................62
png .............................................61
portrait ..........................................79
Previous record ..................................57, 60
print .............................................31
preview ..........................................82
Thesaurus listing ..................................73
to e-mail .........................................81
Print ..............................................58, 61, 79
print to file .......................................80
Print wizard ......................................79
printer
properties .......................................79
select .............................................79
printing
number of copies ................................82
term list .........................................73
pseudonym ......................................69